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Getting Started

■ Chapter 1. Introducing the Veritas High Availability Agent for SAP Web
Application Server

■ Chapter 2. Installing and configuring the SAP Web Application Server for high
availability
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Introducing the Veritas
High Availability Agent for
SAP Web Application
Server

This chapter includes the following topics:

■ About the Veritas High Availability agent for SAP Web Application Server

■ How is application availability achieved in a physical environment

■ How does the Veritas High Availability solution work

■ Agent functions

■ Agent attributes for SAP Web Application Server

■ Installing the agent for SAP Web Application Server

About the Veritas High Availability agent for SAP
Web Application Server

The Cluster Server agents monitor specific resources within an enterprise
application, determine the status of these resources, and start or stop them according
to external events.

The Veritas High Availability agent for SAP Web Application Server provides high
availability for SAP NetWeaver 7.1, 7.3, and 7.4 in a cluster. The agent is designed
to support a wide range of SAP NetWeaver environments which include SAP
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NetWeaver 7.1, 7.3, and 7.4; SAP NetWeaver CE 7.1 and 7.3; SAP NetWeaver
Mobile 7.1 and 7.3; and SAP NetWeaver PI 7.1 and 7.3.

The Veritas High Availability agent for SAP Web Application Server brings SAP
instances online, monitors the instances, and takes the instances offline. The agent
monitors the system processes and server states, and can shut down the server
in case of a failover.

The agent supports the following SAP instance types:

■ Central Services Instance

■ Application Server Instance

■ Enqueue Replication Server Instance

The agent supports the following SAP Web Application Server Usage Types:

■ ABAP

■ Java

■ Add-In (ABAP + Java)

Typical SAP Web Application Server configuration in a VCS cluster
A typical SAP Web Application Server configuration in a VCS cluster has the
following characteristics:

■ VCS is installed and configured in a two-node cluster.

■ The SAP Web Application Server instance binaries are installed locally on both
nodes or on shared disks.

■ The Veritas High Availability agent for SAP Web Application Server is installed
on the both nodes.

■ The drive:\usr\sap directory is shared with name sapmnt and saploc.
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Figure 1-1 depicts a configuration where SAP Web Application Server
instance binaries and SYS are installed completely on shared
disks.

Public Network

Shared disks / diskgroups

VCS Private Network

SAP instance binaries and
SYS on shared disks

Node 1
Node 2
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Figure 1-2 depicts a configuration where SAP Web Application Server
instance binaries are installed locally on each node and SYS is
installed on shared disks.

Public Network

Shared disks / diskgroups

VCS Private Network
Node 1 Node 2

SAP instance binaries

SAP instance binaries

SYS on shared disks

How is application availability achieved in a
physical environment

The VCS agents continuously monitor the application, storage, and network
components that the application uses in the cluster. The agents are able to detect
failures in all of these components. For example, an application-level failure such
as a configured application virtual server or application service becoming unavailable,
a fault in the storage such as a configured disk becoming inaccessible, or a network
failure.

When a fault occurs, VCS fails over the application service group to the next
available system in the application service group’s system list. A service group
failover means that the VCS storage agents deport and import the disks or LUNs
on the new system. The VCS network agents bring the network components online
and the application-specific agents then start the application services on the new
system.

In a disaster recovery cluster configuration, VCS first attempts to failover the
application service group within the local cluster. If all the systems in the local cluster
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are unavailable, VCS attempts to failover the service group to a system at the
remote site.

In a NetApp environment, the VCS NetApp agents perform the following actions in
that order:

■ Connect the virtual disks (LUNs) to the target hosts (NetAppSnapDrive agent).

■ Perform amirror break that enables write access to the target (NetAppSnapMirror
agent).

■ Reverse the direction of replication by demoting the original source to a target,
and begin replicating from the new source (NetAppSnapMirror agent).

If replication is set up using Volume Replicator (Volume Replicator), the Volume
Replicator replication agents make the Secondary RVG at the remote site
write-enabled so that it becomes the new Primary. After the storage is connected,
VCS starts the application services on the new system at the remote site. The data
that is replicated to the remote site is used to restore the application services to the
clients.

How does the Veritas High Availability solution
work

The Veritas High Availability solution for VMware employs Cluster Server (VCS)
and its agent framework to monitor the state of applications and their dependent
components running on the virtual machines that use non-shared storage. Specific
agents are available to monitor the application, storage, and network components.
Together, these agents monitor the overall health of the configured applications by
running specific commands, tests, or scripts.

The storage configuration in the VMware virtual environment determines how VCS
functions differently in a non-shared virtual environment. The non-shared storage
configuration in the VMware virtual environment involves the VMware VMDK and
RDM disks that reside on the shared datastore. This datastore is accessible to
multiple virtual machines. However, the disks are attached to a single virtual machine
at any given point of time. VCS provides a new storage agent “VMwareDisks” that
communicates with the VMware ESX/ESXi hosts to perform the disk detach and
attach operations to move the storage disk between the virtual machines, in a VCS
cluster.
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Note: By default the VMwareDisks agent communicates with the ESX/ESXi host
to perform the disk detach and attach operations. However, instead of the ESX/ESXi
hosts you can choose to communicate with the vCenter Server to perform these
operations.

See “How the VMwareDisks agent communicates with the vCenter Server instead
of the ESX/ESXi host” on page 15.

In event of an application failure, the agents attempt to restart the application
services and components for a configurable number of times. If the application fails
to start, they initiate an application fail over to the failover target system. During the
fail over, the VMwareDisks agent moves the storage disk to the failover target
system, the network agents bring the network components online, and the
application-specific agents then start the application services on the failover target
system.

In case of a virtual machine fault, the VCS agents begin to fail over the application
to the failover target system. The VMwareDisks agent sends a disk detach request
to the ESX/ESXi host. After the detach operation is successful, the agent proceeds
to attach the disks to the new failover target system.

In a scenario where the ESX/ESXi host itself faults, the VCS agents begin to fail
over the application to the failover target system that resides on another host. The
VMwareDisks agent communicates with the new ESX/ESXi host and initiates a disk
detach operation on the faulted virtual machine. The agent then attaches the disk
to the new failover target virtual machine.

In event of a failure in a site recovery configuration, the following tasks are performed
for application monitoring continuity:

■ The virtual machines at the protected site are failed over to the recovery site.

■ The pre-online script defined in the form of a command in the SRM recovery
plan applies the specified attribute values for the application components.

■ The status monitoring script retrieves the application status.

■ The network agents bring the network components online and the
application-specific agents start the application services on the failover target
system.

For details on the VCS configuration concepts and clustering topologies, refer to
the Cluster Server Administrator’s Guide.

For details on the application agents, refer to the application-specific agent guide.

For details on the storage agents, refer to the Cluster Server Bundled Agents
Reference Guide.
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How the VMwareDisks agent communicates with the vCenter Server
instead of the ESX/ESXi host

In addition to the ESX hosts the VMwareDisks agent can also communicate the
disk deatch and attach operations with the vCenter Server to which the virtual
machines belong.

In this scenario, in event of a failure, the VMwareDisks agent sends the disk detach
and attach requests to the vCenter Server (instead of the ESX hosts). The vCenter
Server then notifies the ESX host for these operations. Since the communication
is directed through the vCenter Server, the agent successfully detaches and attaches
the disks even if the ESX host and the virtual machines reside in a different network.

In a scenario where the host ESX/ESXi itself faults, the VMareDisks agent from the
target virtual machine sends a request to the vCenter Server to detach the disks
from the failed virtual machine. However, since the host ESX has faulted, the request
to detach the disks fails. The VMwareDisks agent from the target virtual machine
now sends the disk attach request. The vCenter Server then processes this request
and disks are attached to the target virtual machine. The application availability is
thus not affected.

Limitation
The configuration of VMwareDisks agent to communicate with the vCenter Server
has the following limitation:

If VMHA is not enabled and the host ESX faults, then even after the disks are
attached to the target virtual machine they remain attached to the failed virtual
machine. This issue occurs because the request to detach the disks fails since the
host ESX itself has faulted. The agent then sends the disk attach request to the
vCenter Server and attaches the disks to the target virtual machine.

Even though the application availability is not impacted, the subsequent power ON
of the faulted virtual machine fails. This issue occurs because of the stale link
between the virtual machine and the disks attached. Even though the disks are
now attached to the target virtual machine the stale link with the failed virtual machine
still exists.

Workaround
As a workaround, youmust manually detach the disks from the failed virtual machine
and then power ON the machine.

About the vCenter Server user account privileges
You must have the administrative privileges or must be a root user to communicate
the disk detach and attach operations through the vCenter Server. If the vCenter
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Server user account fails to have the administrative privileges or is not a root user,
then the disk detach and attach operation may fail, in event of a failure.

If you do not want to use the administrator user account or the root user, then you
must create a role and add the following privileges to the created role:

■ "Low level file operations” on datastore

■ “Add existing disk” on virtual machine

■ “Change resource” on virtual machine

■ “Remove disk” on virtual machine

After you create a role and add the required privileges, you must add a local user
to the created role. You can choose to add an existing user or create a new user.

Refer to the VMware product documentation for details on creating a role and adding
a user to the created role.

Typical VCS cluster configuration in a virtual environment
A typical VCS cluster configuration in a VMware virtual environment involves two
or more virtual machines. The virtual machine on which the application is active,
accesses a non-shared VMware VMDK or RDM disk that resides on a VMware
datastore.

The virtual machines involved in the VCS cluster configuration may belong to a
single ESX host or could reside on separate ESX hosts. If the virtual machines
reside on separate ESX hosts, the datastore on which the VMware VMDK or RDM
disks (on which the application data is stored) reside must be accessible to each
of these ESX hosts.

The application binaries are installed on the virtual machines and the data files are
installed on the VMware disk drive. The VCS agents monitor the application
components and services, and the storage and network components that the
application uses.

During a failover, the VCS storage agents (MountV-VMNSDg-VMwareDisks in case
of SFW storage, Mount-NativeDisks-VMwareDisks in case of LDM storage) move
the VMware disks to the new system. The VCS network agents bring the network
components online, and the application-specific agents then start the application
services on the new system.

In a site recovery environment, Veritas High Availability solution additionally provides
script files for the following tasks. These files are invoked when the SRM recovery
plan is executed.

■ Set up communication between the vCenter Server and the SRM Server at the
recovery site and the virtual machines at the protected site.
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■ Assign a SiteID to both the sites.

■ Specify attribute values for the application components at the respective site.

■ Retrieve the application status in the SRM recovery report, after the virtual
machine is started at the recovery site.

Figure 1-3 Typical cluster configuration in a VMware virtual environment

Agent functions

Online
The online function performs the following tasks:

■ Validates the values of the agent attributes required to bring the SAP instance
online.

■ Performs a preliminary check to ensure that the SAP instance is not running
already on the specified node in the cluster.

■ Starts the SAP Windows service SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■ Starts the SAP instance using the startsap.exe utility.
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■ Ensures that the instance is initialized successfully.

Offline
The offline function performs the following tasks:

■ Validates the values of the agent attributes required to bring the SAP instance
offline.

■ Performs a preliminary check to ensure that the SAP instance is not already
offline.

■ Stops the SAP instance using the stopsap.exe utility.

■ Stops the SAP Windows service. SAPSID_InstID, where InstID is the last two
characters of the InstName attribute.

■ Kills any remaining SAP instance processes to ensure that the instance
processes are removed completely.

Monitor
The monitor function performs the following tasks:

■ Validates the values of the agent attributes required to monitor the SAP instance.

■ Performs a first-level monitor check as follows:

■ The function verifies that the SAP Windows service SAPSAPSID_InstID is
running, where InstID is the last two characters of the InstName attribute.

■ Verifies that all processes that the ProcMon attribute lists are running.

■ If the value of SecondLevelMonitor attribute is greater than 0, themonitor function
performs a more thorough check of the SAP instance as follows:

■ For APPSERV instances, the function uses the following utilities to perform
this check:

SAP utility usedServer type

sapcontrol.exeSAPWeb Application
Server as ABAP

sapcontrol.exeSAPWeb Application
Server as Java

sapcontrol.exeSAPWeb Application
Server as Add-In
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■ For an Enqueue or Enqueue Replication server instance, the function uses
the ensmon.exe utility.

■ If the MonitorProgram attribute specifies a custommonitor program, the monitor
function executes the specified program.
See “Executing a custom monitor program” on page 68.

Clean
■ Uses SAP’s sapsrvkill.exe utility to stop all processes of the particular SAP

instance.

■ Stops SAPSAPSID_InstID, the SAP Windows service for the instance.

■ The clean function identifies and kills any remaining SAP instance processes
using the unique combination of the SAPSID attribute and InstID, that is the last
two characters of the InstName attribute. All these processes must also belong
to the SAPServiceSAPSID or sapsidadm user.

Agent attributes for SAP Web Application Server
In a virtual environment, the Veritas High Availability ConfigurationWizard discovers
the required attributes. You can use CLI commands to configure any of the optional
attributes.

Table 1-1 shows the required attributes for configuring a SAP Web Application
Server instance.

Table 1-1 Required attributes

DescriptionRequired attributes

The logging detail performed by the agent for the resource. The
valid values are:

INFO: Logs error messages

TRACE: Logs error and trace messages. TRACE is very verbose
and should only be used during initial configuration or for
troubleshooting and diagnostic operations.

Type and dimension: string-scalar

Default: INFO

Example: TRACE

ResLoglevel
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Table 1-1 Required attributes (continued)

DescriptionRequired attributes

Windows user name used to start the SAP instance. This user must
be dedicated to all the SAP instances within an SAP system. The
format is sapsidadm.

Type and dimension: string-scalar

Default: No default value

Example: piladm

SAPAdmin

Windows domain name to which the SAPAdmin user belongs.

Note: If SAPAdmin does not belong to a Windows domain, use
the cluster localization settings to specify the local computer name
for each system.

Type and dimension: string-scalar

Default: No default value

Example: SYMCORP

SAPAdminDomain

Password for the SAPAdmin user.

Use the vcsencrypt -agent command to encrypt the password.
If you are using the VCS GUI, the GUI automatically encrypts the
password.

Type and dimension: string-scalar

Default: No default value

Example: vxfgh28skbsj

SAPAdminPassword

Virtual IP host name (LANMAN name) for the SAP instance. If the
instance is installed with location hostname, use the local system
name as this attribute value.

Type and dimension: string-scalar

Default: No default value

Example: sappi1scs

SAPHost

The absolute path to the SAP base directory. This attribute is used
to locate programs that the agent uses for start, stop, and clean
functions.

Example 1: C:\usr\sap\PI1\DVEBMSG00\exe

Example 2: C:\usr\sap\PI1\ASCS01\exe

Default: No default value

SAPHome
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Table 1-1 Required attributes (continued)

DescriptionRequired attributes

Windows user name used to start the SAP Windows service for an
SAPSID. This user must be dedicated to all the SAP services under
one SAP system, and must not be used by any other SAP service
or instance under a different SAP system, even in the same cluster.

Note: Do not include the domain name in the value for this attribute.
Use the SAPAdminDomain attribute to specify domain information.

Type and dimension: string-scalar

Default: No default value

Example: SAPServicePI1

SAPServiceUser

SAP system name. This attribute starts with an alphabetic character
and is exactly 3 characters in length. Ensure that the alphabetic
characters used in this attribute are in uppercase only. SAPSID is
defined during the SAP installation.

Type and dimension: string-scalar

Default: No default value

Example: PI1

SAPSID

String identifier that classifies and describes the SAP server instance
type. The InstType values are not case sensitive.

The valid values are:

APPSERV: SAP Application Server

ENQUEUE: SAP Central Services

ENQREP: SAP Enqueue Replication Server

SMDA: Solution Manager Diagnostics Agent

Type and dimension: string-scalar

Default: APPSERV

Example: ENQUEUE

InstType
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Table 1-1 Required attributes (continued)

DescriptionRequired attributes

Uniquely identifies an SAP server instance, along with the SAPSID
attribute. The last two characters of this attribute specify the value
of the InstID attribute. The InstID and SAPSID attributes together
uniquely identify an SAP instance.

Some examples include the following:

■ ASCS03: SAP Central Services (ABAP)
■ SCS07: SAP Central Services (Java)
■ DVEBMGS00: SAP Primary Application Server (ABAP)
■ D05: SAP Additional Application Server (ABAP)
■ J06: SAP (Primary/Additional) Application Server (Java)
■ ERS04: SAP Enqueue Replication server
■ SMDA97: Solution Manager Diagnostics Agent

Type and dimension: string-scalar

Default: ""

Example: DVEBMGS00

InstName

Specifies the full path and file name of the SAP Instance Profile.
Typically the InstProfile is found in
C:\usr\sap\SAPSID\SYS\profile and has a name of
SAPSID_InstName_hostname.

Type and dimension: string-scalar

Default: No default value

Example: C:\usr\sap\PI1\SYS\profile\PI1_DVEBMGS00_sappi1pas

InstProfile

The list of SAP processes that the monitor function must monitor
during a first-level check of an SAP instance. The entries in this list
are separated by a space and can be specified in any order. The
valid values are:

APPSERV: disp+work.exe igswd.exe jstart.exe gwrd.exe icman.exe

ENQUEUE: msg_server.exe enserver.exe gwrd.exe

ENQREP: enrepserver.exe

SMDA: jstart.exe

Type and dimension: vector-scalar

Default: No default value

Example: disp+work.exe

ProcMon
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Table 1-1 Required attributes (continued)

DescriptionRequired attributes

The directory that defines the location of the sapcontrol.exe or
ensmon.exe commands. The agent for SAP WebAS uses these
commands for second-level monitoring.

This functionality is not a part of the base SAP installation. Hence,
the value of this attribute may be different from the SAPHome
attribute.

Type and dimension: string-scalar

Default: No default value

Example: C:\usr\sap\AAV\SYS\exe\uc\NTAMD64

SAPMonHome

Specifies the SAPCentral Services instance resource name in VCS.
This attribute is set only for Enqueue Replication Server (ERS) and
will be used by both Enqueue and Enqueue Replication Servers to
query others status during startup and failover.

Type and dimension: string-scalar

Default: No default value

Example: SAPPI1SCS_scs

EnqSrvResName

Table 1-2 shows the optional attributes for configuring an SAP Web Application
Server instance.
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Table 1-2 Optional attributes

DescriptionAttribute

Used to enable second-level monitoring and specify the interval
for the same. Second-level monitoring is a deeper, more thorough
state check of the configured SAP instance. The numeric value
specifies how often the second-level monitoring routines are run.
0 means never run the second-level monitoring routines, 1 means
run routines every monitor interval, 2 means run routines every
second monitor interval, and so on.

Note: Exercise caution while setting SecondLevelMonitor to large
numbers. For example, if the MonitorInterval is set to 60 seconds
and the SecondLevelMonitor is set to 100, then sapcontrol is
executed every 100 minutes, which may not be as often as
intended. For maximum flexibility, no upper limit is defined for
SecondLevelMonitor.

For Java and Add-In systems, if SecondLevelMonitor is enabled
and if resources are going to unknown state, change ResLogLevel
to TRACE. After you change ResLogLevel to TRACE, you might
encounter the following error message:

J2EEGetProcessList FAIL: HTTP error, HTTP/1.1 401
Unauthorized.

If you encounter the above-mentioned error message, edit the
instance profile, add the following parameter, and restart the
instance service:

service/protectedwebmethods =

Type and dimension: integer-scalar

Default: 0

Example: 1

SecondLevelMonitor
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Table 1-2 Optional attributes (continued)

DescriptionAttribute

Full path and file name of an external, user-supplied monitor
program. If specified, the monitor function executes this file to
perform an additional server state check. There are no restrictions
for what actions the external monitor program performs, to
determine the state of a SAP instance server. The only constraint
is that the external monitor programmust return one of the following
integer values:

■ 0 (server is online)
■ 110 (server is online)
■ 100 (server is offline)
■ 1 (server is offline)
■ 99 or anything else (server state is unknown)

Note: Veritas recommends storing the external monitor program
in the shared disk directory to ensure the file is always available
on the online system. Arguments are supported.

Type and dimension: string-scalar

Default: No default value

Example 1: C:\usr\sap\PI1\DVEBMGS00\work\mymonitor.bat

Example 2: C:\usr\sap\PI1\DVEBMGS00\work\mymonitor.exe arg1
arg2

MonitorProgram

Installing the agent for SAP Web Application
Server

During the installation of the VCS server components, the High Availability
application agents are also installed. These High Availability application agents are
also available in the form of an agent pack, which is released on a quarterly basis.
The agent pack includes support for new applications as well as fixes and
enhancements to existing agents. You can install the agent pack on an existing
VCS installation.

You can download and install the latest agent pack from the Veritas Operations
Readiness Tools (SORT) site: https://sort.veritas.com/agents.

Refer to the product installation guide for instructions on installing and upgrading
VCS.
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Installing and configuring
the SAP Web Application
Server for high availability

This chapter includes the following topics:

■ Monitoring an SAP instance

■ About installing SAP Web Application Server for high availability

■ About configuring SAP Web Application Server for high availability

■ Setting up SAP systems for clustering

■ Installing SAP system using Virtual Hostname

■ Configuring the agent for message server restart

■ Configuring the Enqueue Replication Server

■ Clustering an SAP instance

■ Configuring the SAP systems on Windows Server 2008/2012

Monitoring an SAP instance
Themonitor operation performs process level check to ensure the proper functioning
of an SAP instance.

The ProcMon attribute specifies the processes that must be running successfully
for a particular SAP instance type. The monitor operation uses this list of processes
to scan the process table, and verify that the processes are running successfully.
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Table 2-1 lists valid values of the ProcMon attribute

Table 2-1 Values of ProcMon attribute

Value of ProcMon
attribute

SAP instance typeSAP usage type

enrepserver.exeENQREPABAP

jstart.exe

igswd.exe and icman.exe are
optional

APPSERVJava

enserver.exe

msg_server.exe

gwrd.exe is optional

ENQUEUEJava

enrepserver.exeENQREPJava

disp+work.exe

jstart.exe

igswd.exe, icman.exe and
gwrd.exe are optional

APPSERVAdd-In (ABAP + Java)

enserver.exe

msg_server.exe

ENQUEUE (ABAP)Add-In (ABAP +Java)

enrepserver.exeENQREP (ABAP)Add-In (ABAP +Java)

enserver.exe

msg_server.exe

gwrd.exe is optional

ENQUEUE (Java)Add-In (ABAP +Java)

enrepserver.exeENQREP (Java)Add-In (ABAP +Java)

jstart.exeSMDAJava

jstart.exeSMDAAdd-In (ABAP +Java)

The monitor operation takes a snapshot of the running processes table. The
operation compares the processes that the ProcMon attribute specifies, to the set
of running processes. If any process is missing, the operation declares the SAP
instance as offline, and bypasses further monitor operations.
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About installing SAP Web Application Server for
high availability

In a VCS environment, you can install SAP NetWeaver in the following ways:

Install the SAP instance binaries and SYS directory on
shared disks

SAP instance on shared disk

Install the SAP instance binaries on local disk and SYS
directory on shared disks

SAP instance on shared disk

When installing SAP NetWeaver, ensure that the login_name, group_name for the
sidadm and SAPServiceSID is the same on all the nodes.

For more details refer to SAP documentation.

About configuring SAP Web Application Server
for high availability

The guidelines for configuring SAP NetWeaver for high availability are as follows:

■ In a service group, keep the single point of failure as minimal as possible and
watch the application startup time.

■ Assign a virtual hostname to the component within the switchover environment.
Since the physical hostname changes with the switchover, this is a must have
requirement.

■ Based on the expected failover time configure the reconnection parameters for
all software components and enable its automatic reconnection.

■ Configure sapcpe to copy the instance specific executables and binaries from
a central file system to the instance executable directory, during the instance
startup.

Setting up SAP systems for clustering
This topic describes the procedure to install and configure SAP NetWeaver on a
Windows system, so that you can cluster the system in a Cluster Server (VCS)
environment.

Veritas recommends installing and clustering a database server for SAP to minimize
SAP system downtime. An SAP system downtime may happen due to database
unavailability.
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In this installation, it is assumed that you are setting up the system on two or more
nodes, and clustering these nodes in a VCS environment.

Note: Veritas strongly recommends that a trained SAP consultant be involved in
performing the installation procedure.

Installing SAP systems using a virtual hostname
An SAP system can be installed in HA environment directly using virtual hostnames.
To install an SAP system using a virtual hostname, perform the following steps:

Note: Before installing an SAP system refer to the SAP installation documentation.

To install an SAP system using a virtual hostname

1 Log in as a user with domain administrator rights.

2 Create a service group with IP and Lanman resources for SAP instance.

3 Bring the service group online.

4 On the node that has the service group online, start the SAP instance
installation.

Note: Do not double-click the sapinst.exe file to launch the SAP installation
GUI. Use the SAPINST_USE_HOSTNAME parameter to launch the SAP
installation GUI in a virtual environment.

5 On the Master DVD, navigate to the directory havingsapinst.exe tool.

At the command prompt, run the command:

path\sapinst.exe SAPINST_USE_HOSTNAME=Virtual Host Name

Where,

Virtual Host Name is the virtual Lanman name that you created in step 2 above.

6 From the installation GUI, select High Availability System >Based on [AS
ABAP/AS Java/AS ABAP and AS Java].

Select the appropriate option based on the usage type of the system you are
planning to install and follow the instructions to complete the installation.
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Installing SAP system using Virtual Hostname
An SAP system can be installed directly using virtual hostnames. To install SAP
system using virtual hostname, perform the following steps:

Note: Before installing SAP system refer to SAP Installation documentation.

To install SAP instances using Virtual Hostname

1 Log in as a user that has domain administrator rights.

2 Create a VCS Service Group with IP and Lanman resources for SAP instance.

For details about creating VCS Service Groups, refer to the VCS user
documentation.

3 Before beginning to install the SAP instance, bring the Service Group online.

4 On the node that has the Service Group online, start the SAP instance
installation.

Note: Do not double-click the sapinst.exe file to launch the SAP installation
GUI. Use the SAPINST_USE_HOSTNAME parameter to launch the SAP
installation GUI in a virtual environment.

5 Navigate to the directory where sapinst.exe tool is present in the Master DVD.

At the command prompt, run the following command:

path\sapinst.exe SAPINST_USE_HOSTNAME=Virtual Host Name

where,

Virtual Host Name is the virtual Lanman name that you created in step 2.

6 From the installation GUI, select the usage type of system you are planning to
install and follow the instructions to complete the installation.

Configuring the agent for message server restart
In case the message server process fails, the Veritas High Availability agent for
SAP Web Application Server supports the message server restart through SAP
service (SAPSID_InstID) process sapstartsrv.exe

In case of unexpected termination, to avail the advantage of this restart technology
without failing over the entire (A)SCS instance, the SAP administrator must modify
the Instance profile for (A)SCS instance and set the new profile parameters.
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Note: The Veritas High Availability agent for SAPWeb Application Server does not
support restart of the ‘enserver.exe’ Enqueue server process.

To restart the message server, use the following syntax in the start profile:

Restart_Program_xx = local program name program arguments

For example, the modified syntax for the message server is as follows:

Restart_Program_02 = local $(_MS) pf=$(_PF)

By default sapstartsrv.exe restarts the message server without any delay.

For more information on how to restart the process of a program through
sapstartsrv.exe, refer to SAP Note 729945 and related notes.

Note: Veritas recommends that you carefully study the SAP note before you modify
the profile files for (A)SCS instance.

Configuring the Enqueue Replication Server
Configuration of the Enqueue Replication Server for SAP Web Application Server
can either be done manually, or by using SAPInst.

Configuring the Enqueue Replication Server manually
To manually configure the Enqueue Replication Server for SAP Web
Application Server

1 Enable replication in the (A)SCS instance by adding the following parameter
to the instance profile of (A)SCS instance:

(SAPSID_InstName_VirtualHostname).

enque/server/replication = true

Restart the (A)SCS instance to make the change effective.

Let us assume a two-node software failover cluster, running on the physical
hosts—host A and host B, and a clustered (A) SCS instance with the following
parameters.

■ SCS SAPSID = PLL

■ SCS INSTNO = 01

■ SCS HOST = sapscshost (virtual host name)
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This instance (that is, the Enqueue Server’s lock table) must be protected with
an ERS instance as follows:

■ ERS SAPSID = PLL

■ ERS INSTNO = 11 (a free instance number)

■ ERS HOST = sapershost (virtual hostname)

2 On one of the physical hosts ( host A or host B) perform the following steps as
user sidadm or domain administrator:

Create the directory structure as follows:

drive:\usr\sap\PLL\ERS11\exe

drive:\usr\sap\PLL\ERS11\log

drive:\usr\sap\PLL\ERS11\data

drive:\usr\sap\PLL\ERS11\work

3 Copy all the binaries from (A)SCS instance exe directory into the ERS instance
exe directory.
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4 Create a new ERS instance profile in drive:\usr\sap\PLL\SYS\profile.

SAPSYSTEMNAME = PLL

SAPSYSTEM = 11

INSTANCE_NAME = ERS11

DIR_CT_RUN = $(DIR_EXE_ROOT)\$(OS_UNICODE)\NTAMD64

DIR_INSTANCE = <drive>:\usr\sap\$(SAPSYSTEMNAME)\$(INSTANCE_NAME)

DIR_EXECUTABLE = $(DIR_INSTANCE)\exe

DIR_PROFILE = $(DIR_INSTALL)/profile

_PF = $(DIR_PROFILE)\PLL_ERS11_sapershost

SAPGLOBALHOST = sapscshost

SAPLOCALHOST = sapershost

#----------------------------------------------------------------

# Copy SAP Executables

#----------------------------------------------------------------

_CPARG0 = list:$(DIR_CT_RUN)/scs.lst

Start_Program_01 = immediate $(DIR_CT_RUN)\sapcpe$(FT_EXE) pf=$(_PF)

$(_CPARG0)

#-----------------------------------------------------------------

# Settings for enqueue monitoring tools (enqt, ensmon)

#-----------------------------------------------------------------

enque/process_location = REMOTESA

rdisp/enqname = $(rdisp/myname)

#-----------------------------------------------------------------

# standalone enqueue details from (A)SCS instance

#-----------------------------------------------------------------

SCSID = 01

SCSHOST = sapscshost

enque/serverinst = $(SCSID)

enque/serverhost = $(SCSHOST)

enque/serverport = 32$(SCSID)

enque/enrep/poll_interval = 0

enque/enrep/poll_timeout = 120

enque/enrep/inactive_action = sleep

#-----------------------------------------------------------------

# Start enqueue replication server

#-----------------------------------------------------------------
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_ER = $(DIR_EXECUTABLE)\enrepserver$(FT_EXE)

Start_Program_02 = local $(_ER) pf=$(_PFL) NR=$(SCSID)

For DIR_CT_RUN in this ERS profile, take the value DIR_CT_RUN from the
(A)SCS instance profile. If the (A)SCS instance has not configured
DIR_CT_RUN in its profiles, take the value specified for DIR_EXECUTABLE
from the (A)SCS instance profile.

It is essential that the binaries from (A)SCS and ERS instance are from the
same binary set.

5 Use the sapstartsrv.exe command to create an SAP Windows Service for
the Enqueue Replication Server instance.

6 Start the SAP instance for the Enqueue Replication Server. Ensure that the
instance starts successfully.

The SAP instance is now ready for clustering and to control the life time of
Enqueue Replication Server using VCS.

Configuring the Enqueue Replication Server using SAPInst
To configure the Enqueue Replication Server for SAP NetWeaver using
SAPInst

1 Install Enqueue Replication Server using SAPInst with virtual hostname.

# sapinst SAPINST_USE_HOSTNAME=VirtualHostName

2 Modify the Enqueue Replication Instance profile

drive:\usr\sap\SAPSID\SYS\profile\SAPSID_InstName_VHostName

3 Add the following lines under the section "standalone enqueue details from
(A)SCS instance" in the profile file.

enque/poll_interval = 0

enque/poll_timeout = 120

enque/enrep/inactive_action = sleep

enque/table_size = 4096

4 Delete the following lines from the profile file.

Autostart = 1

enque/enrep/hafunc_implementation
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5 Change the Restart_Program_00 to Start_Program_00 Under "Start enqueue
replication server" section.

Start_Program_00 = local $(_ER) pf=$(_PFL) NR=$(SCSID)

6 Control the life time of Enqueue Replication Server using the switchover
solution.

Clustering an SAP instance
This section describes the procedure for clustering an SAP instance.

To cluster an SAP instance, you must first configure the node that hosts the SAP
Central Service Instance ([A]SCS) and then configure all other nodes that you want
to cluster.

Configuring the first node in the cluster
Perform the following tasks on the node on which you installed SAP, the first time.

■ Set the SAP Service to manual.

■ Create the cluster service group for SAP instance.

To configure the first node in the cluster

1 Stop the SAP Central Services Instance.

2 Stop the SAP instance Windows service

SAPSAPSID_No

3 In the instance profile, set the AUTOSTART equal to 0.

4 Configure the SAPSAPSID_No service as follows:

■ Open services.msc. Click Start > Run and enter service.msc.

■ On the Services panel, right-click the SAPSAPSID_No service, and select
Properties.

■ On the General tab, select Manual from the Startup type drop-down list.

■ Click OK.

■ Close and exit the Services panel.

Configuring all other nodes in the cluster
Perform the following tasks on the other remaining cluster nodes:

■ Create the required SAP users and groups.
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■ Set the system and user environment for the SAP system.

■ Enter the required port numbers in the Windows services files.

■ Install Host Agent using sapinst.exe.

■ Create the Windows service for the SAP instance.

To configure all other nodes in the cluster

1 Log in as a domain administrator.

2 Create the following local groups.

■ SAP_SAPSID_LocalAdmin

■ SAP_SAP_LocalAdmin

■ SAP_LocalAdmin

3 Add the SAP_SAPSID_GlobalAdmin domain group to the
SAP_SAPSID_LocalAdmin and SAP_LocalAdmin group.

4 Add the SAP_SAP_GlobalAdmin domain group to the SAP_SAP_LocalAdmin
and SAP_LocalAdmin

5 Add the SAP_SAPSID_GlobalAdmin and SAP_SAP_GlobalAdmin domain
group to the local Administrators group.

For details on creating and adding a new local group and users:

See “Creating and adding local groups and users” on page 44.

6 Click Start > Programs > Administrative Tools > Local Security Policy >
Local Policies > User Right Assignment.

7 Add the following privileges for the sapsidadm user.

■ Act as a part of the Operating System (SeTcbPrivilege)

■ Replace a process-level token (SeAssignPrimaryTokenPrivilege)

■ Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

8 Add the following privileges for the SAPServiceSAPSID user.

■ Log on as a Service (SeServiceLogonRight).

■ Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

■ Access this computer from the network (SeNetworkLogonRight)

■ Deny Log on Locally and Deny Log on through Terminal Services
(SeDenyInteractiveLogOnRight)

9 Change the sapsidadm user environment as follows:
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■ At the command prompt enter,
runas /profile /user:domain\sapsidadm regedit

■ On the Registry Editor panel, click HKEY_CURRENT_USER >
Environment.

■ Modify the user environment based on your Database, SAP Usage Type
and SAPSID.

For example, the following table depicts the registry environment with Oracle
database (PI1) and Add-In installation with SAPSID PI1.

DataTypeName

value not setREG_SZDefault

oraREG_SZDBMS_TYPE

SAPSR3REG_SZdbs_ora_schema

PI1REG_SZdbs_ora_tnsname

C:\j2sdk1.4.2_19-x64REG_SZJAVA_HOME

AMERICAN_AMERICA.UTF8REG_SZNLS_LANG

E:\oracle\PI1\102REG_EXPAND_SZORACLE_HOME

PI1REG_EXPAND_SZORACLE_SID

E:\usr\sap\PI1\SYS\exe\uc\NTAMD64;\

\sappi1scs\sapmnt\PI1\SYS\exe\uc\NTAMD64;

E:\oracle\PI1\102\BIN

REG_EXPAND_SZPATH

E:\oracle\PI1REG_EXPAND_SZSAPDATA_HOME

\\sapi1scs\sapmnt\PI1\SYS\exe\uc\NTAMD64REG_SZSAPEXE

sappi1aasREG_SZSAPLOCALHOST

PI1REG_SZSAPSYSTEMNAME

E:\usr\sap\PI1\tmpREG_EXPAND_SZTEMP

E:\usr\sap\PI1\tmpREG_EXPAND_SZTMP

\\sappi1scs\sapmnt\PI1\SYS\profile\oracleREG_EXPAND_SZTNS_ADMIN

37Installing and configuring the SAP Web Application Server for high availability
Clustering an SAP instance



10 From the first node in the cluster, copy the following service entries for the SAP
instance, from the services file in the %windir%\system32\drivers\etc

directory to the corresponding services file on all other nodes in the cluster.

sapdp<No.> 32<No.>/tcp # SAP System Dispatcher Port

sapdp<No.>s 47<No.>/tcp # SAP System Dispatcher Security Port

sapgw<No.> 33<No.>/tcp # SAP System Gateway Port

sapgw<No.>s 48<No.>/tcp # SAP System Gateway Security Port

sapms<SAPSID> 36<No.>/tcp # SAP System Message Port Number

where,

The value for <No.> is the value of an Instance ID.

11 Move the Service Group from the first node to the node that you are currently
configuring and ensure that the drive:\usr\sap directory is shared with the
names, sapmnt and saploc.

See “Creating sapmnt and saploc share directories” on page 45.

12 Install SAP Host Agent with SAPInst. Follow the steps below to install the SAP
Host agent.

■ In the Master DVD, navigate to the directory containing the sapinst.exe tool.

■ Double-click the sapinst.exe file to launch the SAP installation GUI.

■ Select High Availability System > Based on [AS ABAP/AS Java/AS
ABAP and AS Java] > Host Agent based on the usage type of system
you installed.

■ Follow the instructions to complete the installation.

13 Create the SAPSAPSID_No service as follows:

■ At the command prompt, navigate to the
drive:\usr\sap\SAPSID\InstName\exe directory.

■ Run the sapstartsrv.exe command.

■ In the SAP Service Install/Uninstall dialog box, enter the following values:

SAPSIDSID

InstanceNumberNR
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If, SAPLOCALHOST=SAPGLOBALHOST, then enter the value
as:

drive:\usr\sap\SAPSID
\SYS\profile\SAPSID_InstName
_VirtualHostName

If, SAPLOCALHOST is not equal to SAPGLOBALHOST, then
enter the value as:

\\SAPGLOBALHOST\sapmnt\SAPSID
\SYS\profile\SAPSID_InstName
_VirtualHostName

Profile

domain\SAPServiceSAPSIDUser

SAPServiceSAPSID passwordPassword

manualStartup type

domain\sapsidadmUse
Environment of
User

14 Click OK.

15 Re-register the type library as follows:

■ At the command prompt, navigate to the Drive:\Path\SAP\hostctrl\exe
directory.

■ Run the sapstartsrv.exe command.

■ In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field

■ Click OK.
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16 Create registry entries for the SAPSAPSID_No service.

For example,

DataTypeName

value not setREG_SZDefault

\\sappi1scs\sapmnt\PI1\SYS\exe\

uc\NTAMD64\sapevents.dll

REG_SZEventMessageFile

0x00000007(7)REG_DWORDTypesSupported

17 If an SAP Microsoft Management Console (MMC) is not configured on the
node, register the SAP MMC using the following steps:

■ Access the file sapmmcX64u.msi or sapmmcIA64u.msi from Kernel Install
DVD depending on the OS architecture.

■ Install SAP MMC by executing the msi package.

Note: Veritas recommends that you cluster the SAP Central Services instances for
both ABAP and Java in an Add-In Usage Type in the same service group.

Also, cluster the Enqueue Replication servers for both ABAP and Java in an Add-In
Usage Type in a single Service Group.

Creating and adding domain groups and users
If you do not have domain administrator rights, you can perform the SAP instance
installation and configuration as a domain user who is a member of the local
administrator group.

User accounts
The SAPInst tool creates the following accounts for the SAP system administrator:

This user account is the SAP system administrator account. This
account enables interactive administration of the system.

sapsidadm

This user account is required to start the SAP system. This account
has the local user right to log on as a service.

This account does not allow interactive logon. You need not set
an expiry date for the password. However, you must change the
password at the next logon option.

SAPServiceSID
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Groups
The SAPInst tool creates the following groups during domain installation:

This global group is a domain level SAP administration group for
organizing SAP system administrators. This global group, groups
together the users at the domain level so that they can be placed
in appropriate local groups.

SAP_SAPSID_GlobalAdmin

These are local groups created and maintained on an application
server. A local group has rights only to the system on which the
group is located.

The system on which the local group is located is part of a
particular domain. The local group can contain users and global
groups from this domain.

SAP_SAPSID_LocalAdmin

Though this group is created on all hosts, creating this group on
the transport host is necessary. Members of this group have full
control over the transport directory, drive:\usr\sap\trans. This
directory allows transports to take place between systems.

The SAP_SAPSID_GlobalAdmin groups of all the SAP systems
that are part of the transport infrastructure are added to the
SAP_LocalAdmin group. Therefore, the sapsidadm and
SAPServiceSAPSID users of all systems in the transport
infrastructure are members of the SAP_LocalAdmin group. These
users have the rights necessary to initiate and execute transports.

SAP_LocalAdmin

Adding new domain groups and users
This section describes the procedure to add new domain groups and users. You
can perform this procedure as a domain administrator only.

To create the SAP_SAPSID_GlobalAdmin Global group

1 Log in as a domain administrator on to Domain Controller.

2 Click Start > Programs > Administrative Tools > Active Directory Users
and Computers.

Alternatively,

■ Click Start > Run.

■ In the Open field, enter mmc.

■ In the Console window, click File > Add/Remove Snap-in.

■ In the Add/Remove Snap-in dialog box, click Add.
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■ In the Add Standalone Snap-in dialog box, select Active Directory Users
and Computers.

■ Click Add.

■ Click OK.

3 In the Active Directory Users and Computers dialog box, right-clickUsers, and
select New > Group.

4 In the New Object - Group dialog box, enter the following values:

SAP_SAPSID_GlobalAdmin

Specify this value using the exact and correct uppercase
and lowercase.

Group Name

GlobalGroup scope

SecurityGroup type

5 Click OK.

Creating SAP system users, sapsidadm and
SAPServiceSAPSID
Follow the steps below to create the SAP system users:

To create the SAP system users

1 In the Active Directory Users and Computers dialog box, right-clickUsers, and
select New > User.

2 In the New Object - User dialog box, enter the following values for sapsidadm

NAFirst name

NAInitials

NALast name

sapsidadmFull name

sapsidadmUser logon
name

3 Click Next.

4 Enter the password and confirm the password.
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5 Select Password never expires.

Ensure that no other option is selected.

6 Click Next.

7 Click Finish.

Adding the sapsidadm user to the
SAP_SAPSID_GlobalAdmin Group
To add the sapsidadm user to the SAP_SAPSID_GlobalAdmin Group

1 In the Active Directory Users and Computers dialog box, double-click sapsidadm
under Users.

2 In the sapsidadm Properties dialog box, click Member > Add.

3 In the Select Groups dialog box, select SAP_SAPSID_GlobalAdmin

4 Click Add.

Note: By default, this user is also a member of the Domain Users group.

5 Click OK.

To add the SAPServiceSAPSID user to the
SAP_SAPSID_GlobalAdmin Group
To add the SAPSID service user to the SAP_SAPSID_GlobalAdmin Group

1 In the Active Directory Users and Computers dialog box, double-click
SAPServiceSAPSID under Users.

2 In the SAPServiceSAPSID dialog box, click Member > Add.

3 In the Select Groups dialog box, select SAP_SAPSID_GlobalAdmin.

4 Click Add.

5 Remove the user from the Domain users group.

■ From the Member of list, select SAP_SAPSID_GlobalAdmin

■ Select Set Primary Group

■ Select Domain Users

■ Click Remove to delete the Domain Users group from the Member of list

■ Click OK

■ Exit the Active Directory Users and Computers dialog box.
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Creating and adding local groups and users
This section describes the procedure to add new local groups and users.

Note: This procedure may vary for Windows Server 2008.

To create a local group

1 ClickStart >ControlPanel >Administrative tools >ComputerManagement.

2 In the Computer Management dialog box, select Local Users and Groups.

3 Right-click Group, and select New Group.

4 In the New Group dialog box, enter SAP_SAPSID_LocalAdmin in the Group
name field.

5 Click Add.

6 In the Select Users, Computers or Groups dialog box, enter
domain\SAP_SAPSID_GlobalAdmin in the Object names field.

7 Click OK on the Select Users, Computers, or Groups dialog box.

8 Click OK on the New Group dialog box

To add a domain group to a local group

1 ClickStart >ControlPanel >Administrative tools >ComputerManagement.

2 In the Computer Management Console, select Local Users and Groups
>Groups.

3 In the right panel, double-click Administrators.

4 In the Administrators Properties dialog box, click Add.

5 In the Select Users, Computers, or Groups dialog box,
enterdomain\SAP_SAPSID_GlobalAdmin in the Object names field.

6 Click OK in the Select Users, Computers, or Groups dialog box.

7 Click OK in the Administrators Properties dialog box.

Creating and adding local groups and users
This section describes the procedure to add new local groups and users.

To create a local group

1 ClickStart >ControlPanel >Administrative tools >ComputerManagement.

2 In the Computer Management dialog box, select Local Users and Groups.
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3 Right-click Group, and select New Group.

4 In the New Group dialog box, enter SAP_SAPSID_LocalAdmin in the Group
name field.

5 Click Add.

6 In the Select Users, Computers or Groups dialog box, enter
domain\SAP_SAPSID_GlobalAdmin in the Object names field.

7 Click OK on the Select Users, Computers, or Groups dialog box.

8 Click OK on the New Group dialog box

To add a domain group to a local group

1 ClickStart >ControlPanel >Administrative tools >ComputerManagement.

2 In the Computer Management Console, select Local Users and Groups
>Groups.

3 In the right panel, double-click Administrators.

4 In the Administrators Properties dialog box, click Add.

5 In the Select Users, Computers, or Groups dialog box,
enterdomain\SAP_SAPSID_GlobalAdmin in the Object names field.

6 Click OK in the Select Users, Computers, or Groups dialog box.

7 Click OK in the Administrators Properties dialog box.

Creating sapmnt and saploc share directories
Ensure that the sapmnt and saploc directories are shared, and are accessible by
the SAP system Administrator.

To create the sapmnt and saploc share directories on Windows Server
2008/2012

1 Right-click the drive:\usr\sap directory, and select properties.

2 On the Properties dialog box, click the Sharing tab.

3 Click Advanced Sharing.

4 Select Share this folder option.

5 Enter sapmnt in the Share name field.

6 Click Permissions.

7 In the Permissions for sapmnt dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the sapmnt directory.

8 Click OK in the Permissions for sapmnt dialog box.
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9 In the Properties dialog box, click Advanced Sharing.

10 On the Advanced Sharing dialog box, click Add.

11 On the New Share dialog box, enter saploc in the Share name field.

12 Click OK in the New Share dialog box.

13 Click Permissions.

14 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

15 Click OK in the Permissions for saploc dialog box.

16 Click OK in the New Share dialog box.

17 Click OK in the Advanced Sharing dialog box.

18 Click Close in the Properties dialog box.

Configuring the SAP systems onWindows Server
2008/2012

On Windows Server 2008/2012, you can only access file shares pointing to local
disks with the physical computer name. To be able to define file shares pointing to
shared disks, a “client access point” (one IP address associated with one network
name cluster resource) must already exist in the failover cluster service group to
which the shared disk belongs. Since you can only access file shares pointing to
shared disks with the network name that belongs to the same failover cluster service
group, you can create multiple file shares with the same file share name (for
example, sapmnt) in a failover cluster environment, assuming the file shares belong
to different cluster service groups.

Figure 2-1 shows a typical SAP system installation on aWindows Server 2008/2012
system under VCS environment.
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Figure 2-1 Typical SAP system installation (usingmultiple sapmnt file shares)
on aWindows Server 2008/2012 system under VCS environment

For sample service group configurations on Windows Server 2008/2012,

See “Sample service group configurations for SAP systems on Windows Server
2008/2012” on page 84.
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Configuring the application
for high availability

■ Chapter 3. Configuring the application in a physical environment

■ Chapter 4. Configuring the application in a VMware environment

■ Chapter 5. Optional configuration tasks for the SAP Web Application Server
agent
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Configuring the application
in a physical environment

This chapter includes the following topics:

■ Overview

■ Before configuring the service groups for SAP Web Application Server

■ Configuring service groups with the SAP Web Application Server agent

■ Configuring the SAPWebAS preonline script

Overview
To provide high availability for SAP NetWeaver 7.1, 7.3 and 7.4 components in a
physical environment, you must perform the following tasks:

1. Review and configure the attributes of the agent for SAP Web Application
Server. See “Agent attributes for SAP Web Application Server” on page 19.

2. Create and configure service groups.

You must have administrator privileges to create and configure a service group.
You can configure the service groups using one of the following:

■ Veritas Operations Manager

■ The Cluster Manager (Java console)

■ The command-line.

See “Configuring service groups with the SAP Web Application Server agent”
on page 50.
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Before configuring the service groups for SAP
Web Application Server

Before you configure the SAP Web Application Server service group, you must
perform the following:

■ Verify that VCS is installed and configured on all nodes in the cluster where you
will configure the service group.
Refer to the product installation guide for more information on installing and
configuring VCS.

■ See “About installing SAP Web Application Server for high availability”
on page 28.
See “About configuring SAP Web Application Server for high availability”
on page 28.

■ Verify that the Cluster Server agent for SAP Web Application Server is installed
on all nodes in the cluster.

Configuring service groups with the SAP Web
Application Server agent

While setting up a cluster, you must always ensure that the cluster has some spare
capacity to handle the SAP NetWeaver failover scenarios. For example, in case of
a back-end database failure, the cluster must be able to run another database
instance in conjunction with other running applications. Review the information
about data protection.

The cluster should thus be able to provide application failover by encapsulating the
resources required for an application into a service group. A service group is a
virtualized application that can switch between the cluster nodes. It contains a set
of dependent resources, such as disk groups, disk volumes, file systems, IP
addresses, NIC cards, and dependent application processes. It also includes logic
about the dependencies between the application components.

These service groups should thus be configured such that the cluster can start,
stop, monitor, and switch the service groups between the nodes, depending upon
the server or resource faults. An administrator should also be pro-actively able to
move a service group between cluster nodes to perform preventative maintenance
or apply patches.
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To configure the service groups

1 Change the cluster configuration to read/write mode.

C:\> haconf -makerw

2 Create a service group for SAP NetWeaver

C:\> hagrp -add SAP710-PI1SCS

3 Modify the SystemList attribute for the group, to add systems.

C:\> hagrp -modify SAP710-PI1SCS SystemList vcswin74 0 vcswin75

1

4 Create resources for NIC, IP, Lanman,VMDg, and MountV in the service group.

C:\> hares -add SAP710-PI1SCS_nic NIC SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_ip IP SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_lanman Lanman SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_mnt MountV SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_vmdg VMDg SAP710-PI1SCS

For more details on creating and modifying resource attributes for NIC, IP,
Lanman, VMDg andMountV refer to Cluster Server Bundled Agents Reference
Guide.

5 Create links between the resources.

C:\> hares -link SAP710-PI1SCS_ip SAP710-PI1SCS_nic

C:\> hares -link SAP710-PI1SCS_lanman SAP710-PI1SCS_ip

C:\> hares -link SAP710-PI1SCS_mnt SAP710-PI1SCS_vmdg

6 Create SAPWebAS resource for applications based on SAP NetWeaver

C:\> hares -add SAP710-PI1SCS_scs SAPWebAS SAP710-PI1SCS

Based on the SAP instance you are clustering, modify the resource attributes.

See “Agent attributes for SAP Web Application Server” on page 19.

7 Create resource dependencies for SAPWebAS resource.

The SAPWebAS resource depends on the Lanman and MountV resources.

C:\> hares -link SAP710-PI1SCS_scs SAP710-PI1SCS_lanman

C:\> hares -link SAP710-PI1SCS_scs SAP710-PI1SCS_mnt
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8 Verify the final resource dependencies for SAP server group.

Group Parent Child

SAP710-PI1SCS SAP710-PI1SCS_scs SAP710-PI1SCS_lanman

SAP710-PI1SCS SAP710-PI1SCS_scs SAP710-PI1SCS_mnt

SAP710-PI1SCS SAP710-PI1SCS_ip SAP710-PI1SCS_nic

SAP710-PI1SCS SAP710-PI1SCS_lanman SAP710-PI1SCS_ip

SAP710-PI1SCS SAP710-PI1SCS_mnt SAP710-PI1SCS_vmdg

9 Save the cluster configuration.

C:\> haconf -dump -makero

Configuring the SAPWebAS preonline script
In a clustered environment, the SAP administrator installs and configures SAP
Enqueue and SAP Enqueue Replication Server. SAP Enqueue and Enqueue
Replication Server have the following requisites:

■ If an Enqueue server instance fails, the server must fail over to the node on
which the Enqueue Replication Server instance is running.

■ If the Enqueue Replication Server instance fails, the instance must fail over to
a node on which Enqueue Server is NOT running.

The SAPWebAS preonline script facilitates proper Enqueue server failover behavior.
The existing VCS preonline script calls the SAPWebAS preonline script.

The SAPWebAS preonline script performs the following tasks:

■ If the service group for which the script is running does not have an Enqueue
server or an Enqueue Replication Server resource, the script returns the control
to the VCS preonline script.

■ If the service group has an Enqueue server or Enqueue Replication Server
resource, the script determines the node on which the online operation can be
performed. The script also ensures that the online operation does not execute
the VCS preonline script again.

To accomplish this failover behavior, you must configure the VCS preonline script.

The VCS preonline trigger calls an external preonline trigger
utility—sapwebaspreonline.exe. The initiated preonline trigger performs the steps
necessary for correct failover behavior of the Enqueue servers. The
sapwebaspreonline.exe utility is located in the %VCS_HOME%\bin\SAPWebAS directory.
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To configure SAPWebAS preonline script

1 Go to the %VCS_HOME%\bin\Trigger directory.

2 Skip this step if the preonline file exists in this directory.

If the preonline file does not exist, copy the sample preonline trigger file from
the %VCS_HOME%\bin\Sample_Triggers directory to the
%VCS_HOME%\bin\Triggers directory, rename the file to preonline, and then
use this file.
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3 Add the following lines to the preonline file:

#--------------------------------------------------------------

# Start sapwebas preonline trigger.

#--------------------------------------------------------------

# Perl preonline.pl <system> <group> <whyonlining>

<systemwheregroupfaulted>

my $system = $ARGV[0];

my $group = $ARGV[1];

my $whyonlining = $ARGV[2];

my $systemwheregroupfaulted = undef;

my $sArgs = join(' ', @ARGV);

VCSAG_LOG_MSG("I", "Arguments [$sArgs]", 15041);

if(defined $ARGV[3]) {

$systemwheregroupfaulted = $ARGV[3];

}

my $SAPWebASPreOnlineTrigger = sprintf("%s\\bin\\SAPWebAS\\

sapwebaspreonline.exe", $vcs_home);

VCSAG_LOG_MSG("I",

"The trigger command is [$SAPPreOnlineTrigger]", 15041);

if(defined $systemwheregroupfaulted)

{

VCSAG_LOG_MSG("I", "The group is faulted on syetem =

[$systemwheregroupfaulted]", 15042);

$CMD = sprintf("\"%s\" %s %s %s %s", $SAPWebASPreOnlineTrigger,

$system, $group, $whyonlining, $systemwheregroupfaulted);

}

else {

$CMD = sprintf("\"%s\" %s %s %s", $SAPWebASPreOnlineTrigger,

$system, $group, $whyonlining);

}

system($CMD);

my $exit_value = $? >> 8;

VCSAG_LOG_MSG("I", "The exit code from the trigger: [$exit_value].",

15046, $exit_value);

if($exit_value == 0) {

VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP executed

successfully.", 15046);

exit;

}

elsif($exit_value == 1) {

VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP FAILED.", 15047);

exit;
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}

else {

VCSAG_LOG_MSG("I", "Unknown PreOnline trigger.", 15048);

}

#--------------------------------------------------------------

# End sapwebas preonline trigger.

#--------------------------------------------------------------

.

.

# give control back to HAD.

if (defined $ARGV[3]) {

‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys $ARGV[0]

-checkpartial $ARGV[3]‘;

exit;

}

‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys $ARGV[0]‘;

exit;

4 Use the following command to set the preonline trigger attribute to true for the
Service Groups to which the Enqueue and Enqueue Replication server
instances belongs:

C:\> hagrp -modify service_group PreOnline 1 -sys system

The preonline script is now configured to facilitate Enqueue and Enqueue Replication
server behavior. You can view the logs in the VCS engine log, engine_A.log.

Note: Once the preonline trigger is configured, you may see unexpected behavior
while manually switching or performing online operations on the Enqueue Replication
service group. This behavior is a result of the control logic within the preonline
trigger that protects the Enqueue lock table. For system maintenance, if you prefer
to perform manual operations on the service groups, you can do so by disabling
the preonline trigger.

To disable the preonline trigger, use the following command:

C:\> hagrp -modify service_group PreOnline 0 -sys system
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Configuring the application
in a VMware environment

This chapter includes the following topics:

■ About configuring application monitoring with Veritas High Availability solution
for VMware

■ Configuring application monitoring for SAP Web Application Server

About configuring application monitoring with
Veritas High Availability solution for VMware

Consider the following before you proceed:

■ You can configure application monitoring on a virtual machine using the Veritas
High Availability ConfigurationWizard for VMware. The wizard is launched when
you click Configure application for high availability on the Veritas High
Availability tab in VMware vSphere Client.
Apart from the Veritas High Availability Configuration Wizard, you can also
configure application monitoring using the Cluster Server (VCS) commands.
For more information, refer to the Cluster Server Administrator's Guide.

■ Veritas recommends that you first configure application monitoring using the
wizard before using VCS commands to add additional components or modify
the existing configuration.
Apart from the application monitoring configuration, the wizard also sets up the
other components required for successful application monitoring.

■ In case the VMwareDisks agent resource is configured manually, care should
be taken not to add the operating system disk in the configuration. The
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VMwareDisks agent does not block this operation. This might lead to a system
crash during failover.

■ If VMware vMotion is triggered at the same time as an application fails over, the
VMwareDisks resource may either fail to go offline or may report an unknown
status. The resource will eventually failover and report online after the vMotion
is successful and the application is online on the target system.

■ VMware snapshot operations may fail if VMwareDisks agent is configured for
a physical RDM type of disk. Currently only virtual RDM disks are supported.

■ Non-shared disks partitioned using GUID Partition Table (GPT) are not
supported. Currently only Master Boot Record (MBR) partition is supported.

■ VMwareDisks agent does not support disks attached to the virtual machine
using IDE controllers. The agent resource reports an unknown if IDE type of
disks are configured.

■ In case VMware HA is disabled and the ESX itself faults, VCS moves the
application to the target failover system on another ESX host. VMwareDisks
agent registers the faulted system on the new ESX host. When you try to power
on the faulted system, you may see the following message in the vSphere Client:

This virtual machine might have been moved or copied.

In order to configure certain management and networking features,

VMware ESX needs to know if this virtual machine was moved or copied.

If you don't know, answer "I copied it".

You must select “I moved it” (instead of the default “I copied it”) on this message
prompt.

■ You must not restore a snapshot on a virtual machine where an application is
currently online, if the snapshot was taken when the application was offline on
that virtual machine. Doing this may cause an unwanted fail over.
This also applies in the reverse scenario; you should not restore a snapshot
where the application was online on a virtual machine, where the application is
currently offline. This may lead to a misconfiguration where the application is
online on multiple systems simultaneously.

■ If you want to suspend a system on which an application is currently online,
then you must first switch the application to a failover target system.
If you suspend the system without switching the application, then VCS moves
the disks along with the application to another system.
Later, when you try to restore the suspended system, VMware does not allow
the operation because the disks that were attached before the system was
suspended are no longer with the system.
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■ While creating a VCS cluster in a virtual environment, you must configure one
of the cluster communication link over a public adapter in addition to the link
configured over a private adapter. To have less VCS cluster communication
over the link using the public adapter, you may assign it low priority. This keeps
the VCS cluster communication intact even if the private network adapters fail.
If the cluster communication is configured over the private adapters only, the
cluster systems may fail to communicate with each other in case of network
failure. In this scenario, each system considers that the other system has faulted,
and then try to gain access to the disks, thereby leading to an application fault.

■ VMware Fault Tolerance does not support adding or removing of non-shared
disks between virtual machines. During a failover, disks that contain application
data cannot be moved to alternate failover systems. Applications that are being
monitored thus cannot be brought online on the failover systems.

■ For cluster communication, you must not select the teamed network adapter or
the independently listed adapters that are a part of the teamed NIC.
A teamed network adapter is a logical NIC, formed by grouping several physical
NICs together. All NICs in a team have an identical MAC address, due to which
you may experience the following issues:

■ SSO configuration failure

■ The application monitoring configuration wizard may fail to discover the
specified network adapters

■ The application monitoring configuration wizard may fail to discover/validate
the specified system name

Configuring application monitoring for SAP Web
Application Server

Configuring an application for high availability involves the following tasks:

1. Configuring the VCS cluster

This task involves selecting the virtual machines on which you want to configure
monitoring and setting up the network communication links between the selected
virtual machines.

See “Configuring the VCS cluster” on page 59.

2. Configuring the application

This task involves configuring the application in one of the following modes:

■ Start/stop mode on a single system: In the event of a failure, the application
is restarted on a virtual machine for a configured number of times.
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■ Failover mode on multiple systems: In the event of a failure, the application
is first restarted on a virtual machine for a configured number of times. If
the application does not restart, the virtual machine fails over to another
ESX host.
When configuring an application in the failover mode, you need to select
the ESX hosts where the virtual machines can fail over.

See “Configuring the application” on page 62.

Configuring the VCS cluster
VCS cluster configuration involves selecting the virtual machines on which you want
to configure high availability and setting up the network communication links between
the selected virtual machines.

To configure the VCS cluster

1 Launch the vSphere Client and connect to the vCenter Server that manages
the virtual machine. On the Inventory view of the vCenter Server, in the left
pane, select the virtual machine where you want to configure application
monitoring. Then, in the right pane, select the Veritas High Availability tab.

2 Skip this step if you have already configured the single sign-on during the guest
installation.

On the Veritas High Availability view, specify the credentials of a user account
that has administrative privileges on the system and then click Configure.

The single sign-on configuration enables the Veritas High Availability Console
to set up a permanent authentication for the user account. After the
authentication is successful, the Veritas High Availability view refreshes and
displays the link to configure the VCS cluster.

3 On the Veritas High Availability view, click Configure a VCS Cluster. This
launches the VCS cluster configuration wizard. Unless you configure a cluster,
you cannot configure an application for monitoring.

4 On the Welcome panel, review the pre-requisites and then click Next.
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5 On the Configuration Inputs panel, specify the systems for the VCS cluster
operations and the user account details for each system.

Note: The specified user account must have administrative privileges on the
system.

The Cluster systems lists the systems that are included in the cluster
configuration. The local system is selected by default.

To add more systems, click Add System and then on the Add System dialog
box, specify the following details of the system that you want to add to the VCS
cluster.

Specify the name or IP address of the system that you want
to add to the VCS cluster.

System Name or IP
address

Specify the user account for the system. The user name
must be in the domain.com\username.

Note: The specified user must be a domain user having
administrative privileges on all the selected system.

User name

Specify the password for the user account mentioned.Password

Uses the specified user account on all the cluster systems.
This option is selected by default.

Use the specified user
account on all systems

The wizard validates the system details and then adds the system to VCS
cluster system list.

6 Skip this step if you do not want to modify the default security settings for your
cluster.

To modify the security settings for the cluster, on the Configuration Inputs
panel, click Advanced Settings . In the Advanced settings dialog box, specify
the following details and then click OK.

Select to configure single sign-on using VCS Authentication
Service for cluster communication.

This option is enabled by default.

Use Single Sign-on

Select to configure a user with administrative privileges to
the cluster.

Specify the user name and password and click OK.

Use VCS user privileges
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7 On the Network Details panel, select the type of communication for the VCS
cluster and then select the adapters to configure the communication links.

Depending on the network over which you want to configure the links, select:

■ Use MAC address for cluster communication (LLT over Ethernet) :
The LLT over Ethernet communication configures the links over the
non-routed network. Choose this mode only if the failover target systems
reside in the same subnet.

■ Use IP address for cluster communication (LLT over UDP): The LLT
over UDP communication configures the links over the routed network. You
can choose this mode regardless of whether the failover target systems
reside in the same subnet or in different subnets. You can select only those
adapters that have an IP address.

You must select a minimum of two adapters per system.

Veritas recommends the following:

■ IP addresses that are assigned to the selected adapters should be in
different subnets.

■ One of the network adapters must be a public adapter. You may assign
low priority to the VCS cluster communication link that uses the public
adapter.

Select a network adapter for the communication links.

You must select a different network adapter for each
communication link.

To configure links over UDP, select the type of IP protocol
and then specify the required details for each communication
link.

Note: Do not select the teamed network adapters and the
independently listed adapters that are a part of the teamed
NIC.

Network Adapter

Specify the IP address for cluster communication over the
specified UDP port.

IP Address

Specify a unique port number for each link. You can use
ports in the range 49152 to 65535.

A specified port for a link is used for all the cluster systems
on that link.

Port

Displays the subnet masks to which the specified IP belongs.Subnet mask
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By default, the VCS cluster communication link that uses the public adapter is
configured as low-priority link. To change the priority, clickModify. In the Modify
low-priority link dialog box, select the link and click OK.

For information about adding or changing the selected network links after the
configuration workflow is complete, see the Cluster Server Administrator's
Guide.

8 On the Configuration Summary panel, specify a cluster name and a cluster ID
of your choice.

Review the VCS cluster configuration details and then click Next to initiate the
configuration.

If the network contains multiple clusters, the wizard verifies the cluster ID with
the IDs assigned to all the accessible clusters in the network. The wizard does
not validate the assigned ID with the clusters that are not accessible during
the validation. Veritas recommends you to validate the uniqueness of the
assigned ID in the existing network.

9 On the Implementation panel, the wizard displays the VCS cluster configuration
tasks and the status of each task. After all the tasks are complete, click Next.

If the configuration tasks fail, click Diagnostic information to check the details
of the failure.

Rectify the cause of the failure and run the wizard again to configure the VCS
cluster.

10 On the Finish panel, click Finish to complete the wizard workflow. This step
completes the VCS cluster configuration.

The Veritas High Availability view now displays the link to configure an
application for high availability.

Configuring the application
Perform the following steps to configure the SAP Web Application Server for high
availability on a virtual machine.
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To configure the application

1 Launch the vSphere Client and connect to the vCenter Server that manages
the virtual machine. On the Inventory view of the vCenter Server, in the left
pane, select the virtual machine where you want to configure application
monitoring. Then, in the right pane, select the Veritas High Availability tab.

Note: Ensure that the disk residing on the shared datastore is attached and
the volumes are mounted on the selected virtual machine.

2 On the Veritas High Availability tab, click Configure Application for High
Availability. This option is available only after a cluster has been configured.
Unless you configure a cluster, you cannot configure an application for
monitoring.

3 On the Welcome panel of the Veritas High Availability Configuration wizard,
review the pre-requisites and then click Next.

4 On the Application Selection panel, select SAP from the Supported Applications
list and then click Next.

Alternatively, you can use the Search box to find the application and then click
Next.

If you want to download any of the Veritas High Availability agents, click the
Download Application Agents (SORT) link to download the agents from the
Veritas Services and Operations Readiness Tools (SORT) site.

https://sort.veritas.com/agents

5 On the SAP Instance Selection panel, select the instance that you want to
configure, enter the SAP administrator's password, and click Next.

Note: The wizard does not display those SAP instances that are already
configured for monitoring.
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6 On the Configuration Inputs panel, select the VCS cluster systems on which
you want to configure the application for high availability and move them to the
Application failover targets list. The local system is selected by default.

Using the up-down arrow keys, you can define the priority order for the failover
systems.

For each system that you assign as a failover target, you must specify the
domain user account details in the appropriate fields on the Edit System dialog
box. The VCS agents use these details to perform domain operations such as
Active Directory updates.

7 On the Virtual Network Details panel, specify the virtual IP and the network
details for the application to be configured and then click Next.

To specify the virtual IP and network details, select the IP protocol and then
specify the following details for each failover system:

Note: You must select the same IP protocol as that selected during the VCS
cluster configuration.

Specify a unique virtual IP address.Virtual IP address

Specify the subnet mask to which the IP address belongs.Subnet mask

Specify a virtual name.Virtual name

Select the network adapter that will host the virtual IP.Network Adapter column

If you want to add another virtual IP address, click Add virtual IP address. A
virtual IP input panel appears, in which you can enter the details as described
earlier in this step.

Note: You can only provide either a set of IPv4 addresses or a set of IPv6
addresses, not both.
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8 On the Target ESX/ESXi Host Details panel, specify the hosts and the
administrative user account details for each host, and then click Next.

Note: This panel appears only if you have selected multiple application failover
targets on the Configuration Inputs panel.

To specify the hosts, click Add ESX/ESXi Host, and on the Add ESX/ESXi
Host dialogue box, specify the following details:

Specify the target ESX hostname or IP address.

The virtual machines will fail over on this ESX host during
vMotion.

The mount points configured on the ESX host where the
application is currently running must be available on the target
ESX host.

ESX/ESXi hostname
or IP address

Specify a user account for the ESX host.

The user account must have administrator privileges on the
specified ESX host.

User name

Specify the password for the user account provided in the User
name text box.

Password

The wizard validates the user account and the storage details on the specified
hosts.

9 On the Configuration Summary panel, review the application configuration
details.

The wizard assigns a unique name to the application service group. Click
Rename to rename the service group.

Click Next to initiate the application monitoring configuration.
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10 On the Implementation panel, the wizard performs the application configuration
tasks.

The wizard displays the status of each task. After all the tasks are complete,
click Next.

If the configuration tasks fail, click Diagnostic information to check the details
of the failure. Rectify the cause of the failure, and run the wizard again to
configure application monitoring.

11 On the Finish panel, click Finish to complete the wizard workflow. This
configures the application for high availability on the selected VCS cluster
systems.

The Veritas High Availability view now displays the application status and its
component dependency.

If the application status shows as not running, click Start to start the configured
components on the system.
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Optional configuration
tasks for the SAP Web
Application Server agent

This chapter includes the following topics:

■ Setting the SAPMonHome attribute

■ Configuring the execution period for agent functions

■ Executing a custom monitor program

■ Preventing early faulting of Java and Add-In instances

Setting the SAPMonHome attribute
The SAPMonHome attribute contains the absolute path to the directory that contains
the binary used for second level monitoring process.

The binaries that are used during second-level monitoring for different SAP usage
types and SAP instances are as follows:

■ For ABAP application Server: sapcontrol.exe

■ For Add-In (ABAP + Java) application server: sapcontrol.exe

■ For Enqueue and Enqueue Replication Server: ensmon.exe

Note: For Java application server and java component of Add-In application server
the agent uses the sapcontrol.exe utility present in SAPHome.
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Configuring the execution period for agent
functions

An agent function is allocated an execution period using the respective time-out
attributes: OnlineTimeout, OfflineTimeout, MonitorTimeout, and CleanTimeout. By
default these values are set to 300, 300, 60 and 60 respectively.

If an agent function executes a program, for example sapcontrol.exe, the program
must execute within the allocated execution period. If the program is unable to
execute within the allocated period, the agent function cancels and terminates the
execution of the program. You must set these timeout attributes to appropriate
values depending on the time required for SAP applications. You can modify these
values with the following command.

hatype -modify TypeName attribute_name attribute_value

Example: C:\> hatype -modify SAPWebAS OnlineTimeout 600

Executing a custom monitor program
Themonitor function executes a custommonitor program to perform a user-defined
SAP WebAS state check.

The monitor function executes the MonitorProgram if the following conditions are
true:

■ The specified utility is a valid executable file.

■ The first level process check indicates that the SAP Web AS instance is online.

■ The SecondLevelMonitor attribute is either set to 0 or 1, and the second level
check indicates that the SAP Web AS instance is online.

■ The SecondLevelMonitor attribute is set to greater than 1, but the second level
check is deferred for this monitoring cycle

The monitor operation interprets the program exit code as follows:

SAP server instance is ONLINE110 or 0

SAP server instance is OFFLINE100 or 1

SAP server instance is UNKNOWN99

SAP server instance is UNKNOWNAny other value
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To ensure that the custom monitor program is always available to the agent
application, Veritas recommends storing the file in a shared directory that is available
on an online node.

Preventing early faulting of Java and Add-In
instances

When you start a SAP Java or a SAP Add-In Application Server Instance, SAP
automatically starts processes such as jstart.exe. Depending upon the available
resources, starting these processes takes some finite time.

The agent for SAP WebAS allows enough time for SAP to start these processes
successfully. The agent checks the status of these processes in definite intervals.
While checking the status of these processes, if the processes are missing, the
agent pauses for a time period that is equal to one-tenth of the value of the
MonitorTimeout attribute before re-checking the status of the processes.

Veritas strongly recommends that the administrator set the MonitorTimeout attribute,
such that the agent gives enough time for these processes to restart if a failure
occurs.

For example, if an add-in server instance takes 9 seconds to restart a failed jstart
process, you must set the value of the MonitorTimeout attribute to at least 90
seconds.
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Troubleshooting the Agent

■ Chapter 6. Troubleshooting the agent for SAP Web Application Server
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Troubleshooting the agent
for SAP Web Application
Server

This chapter includes the following topics:

■ Starting the SAP Web Application Server outside a cluster

■ Troubleshooting common problems

■ Reviewing SAP Web Application Server agent log files

■ Reviewing error log files

■ Checks for an SAP Add-In Usage Types

Starting the SAP Web Application Server outside
a cluster

If you face problems while working with a resource, you must disable the resource
within the cluster framework. A disabled resource is not under the control of the
cluster framework, and so you can test the SAPWeb Application Server independent
of the cluster framework. Refer to the cluster documentation for information about
disabling a resource. You can then restart the SAPWeb Application Server outside
the cluster framework.

Note:Use the same parameters that the resource attributes define within the cluster
framework while restarting the resource outside the framework.
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A sample procedure to start a SAP Web Application Server outside the cluster
framework, is illustrated as follows:

To start a SAP instance outside the cluster framework, using SAP MMC

1 Log in to the system as a sapsidadm user.

2 Use the SAPMicrosoft Management Console (MMC) to start the SAP instance.

Ensure that the SAP instance starts successfully. If the instance starts
successfully outside the cluster, you can attempt to start it inside the cluster
framework.

To start a SAP instance outside the cluster framework, using the command
prompt

1 Log in to the system as a sapsidadm user.

2 Start the SAP Windows service SAPSAPSID_xx for SAP instance, using the
following command:.

drive\> net start SAPSAPSID_xx

3 Use the startsap.exe utility to start the SAP instance. Enter,

drive\>usr\sap\SAPSID\InstName\exe\startsap.exe name=SAPSID

nr=InstID sapdiahost=virtual_hostname

Ensure that the SAP instance starts successfully. If the instance starts
successfully outside the cluster, you can attempt to start it inside the cluster
framework.

Troubleshooting common problems
This section describes some problems that you may face while working with the
Veritas High Availability agent for SAP Web Application Server in a VCS
environment.

Unable to install the Veritas High Availability agent for SAP Web
Application Server

If you are not able to install the Veritas High Availability agent for SAP Web
Application Server, check to see if previous versions of the agent are present in
the system. If present, remove the older agents and attempt to install the agent
again.

Also, ensure that you go through the prerequisites before installing SAP NetWeaver.

72Troubleshooting the agent for SAP Web Application Server
Troubleshooting common problems



Unable to see an entry in the SAP MMC for an SAP instance
If you cannot see any entry for an SAP instance in the SAP MMC, you must
re-register the SAP services as COM Typelibrary Only.

To re-register the SAP services

1 At the command prompt, navigate to drive\Program Files\SAP\hostcntl\exe
directory.

2 Run the sapstartsrv.exe command.

3 In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.

You must re-register the SAP services as described here whenever a change
in the SAP service registration occurs.

The agent for SAP Web Application Server fails to bring online an
SAP instance resource through VCS

Attempt to start the SAP resource outside the VCS environment to ensure that the
resource is working properly.

See “Starting the SAP Web Application Server outside a cluster” on page 71.

You can also view the log files to further diagnose the problem.

See “Reviewing SAP Web Application Server agent log files” on page 75.

SAP instance does not come online, and the startsap.exe command
exits with exit code -1

Check the SAP MMC to ensure that the entry for this SAP instance is present. If
the entry is not present, add the SAP instance in the SAP MMC.

See “Unable to see an entry in the SAP MMC for an SAP instance” on page 73.

Then attempt to bring the SAP instance online.

In case of an Enqueue server failure, the Enqueue server instance
fails to take over the lock table from the Enqueue Replication server
instance

If the Enqueue Replication server instance does not recognize the correct Enqueue
server instance, this problem may occur. Ensure that the value of InstID passed to
the Enqueue Replication server process, enrepserver.exe in the start profile, belongs
to the correct Enqueue server instance.
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The ensmon.exe command returns exit code 4 for a Enqueue server
instance

If the Enqueue Replication server is not configured or is not online, this problem
occurs. Ensure that if the Enqueue Replication server is configured, the instance
is online.

If the Enqueue Replication server instance is not configured, disable the replication
parameter in the Instance profile of the Enqueue server instance:

enque/server/replication = false

The return code of the ensmon.exe command is 8 for an Enqueue
Replication server instance

The return code indicates that the Enqueue server instance is down. When the
Enqueue server instance fails, the ensmon.exe command returns this code when
the instance is switching over to the Enqueue Replication server instance to take
over the instate lock table.

Check the state of the Enqueue server instance.

The Enqueue server instance does not fail over to the correct
Enqueue Replication server instance

This problem occurs if the preonline script is not configured properly. To configure
the preonline script:

See “Configuring the SAPWebAS preonline script” on page 52.

This problem also occurs if the InstType attribute is not set properly. Also make
sure that you configured EnqSrvResName attribute for Enqueue Replication Server
(ERS) Instance resource.

In case of a resource fault, the Service Group does not fail over
If the resource is not set to critical, the Service Group may not fail over. To resolve
the issue, set the resource to critical.
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Reviewing SAPWebApplication Server agent log
files

If you are facing problems while using the VCS agent for SAP Web Application
Server or an SAP server instance, refer to the following sections to access the
relevant files for information about the issue.

Using SAP instance log files
In case of problems while using the VCS agent for SAP Web Application Server,
you can access the SAP instance log files for more information. These log files are
located in the drive:\usr\sap\SAPSID\InstName\work directory.

Using SAP log files
If an SAP server is facing problems, you can access the agent log files to further
diagnose the problem. The log file is drive:\Program Files\Veritas\Cluster
Server\log\SAPWebAS_A.txt.

Reviewing error log files
If you face problems while using SAP NetWeaver instance or the agent for SAP
WebAS, use the log files described in this section to investigate the problems.

Using SAP NetWeaver instance files
If a SAP server is facing problems, you can access the server log files to further
diagnose the problem. The SAP log files are located in the
drive\usr\sap\SAPSID\InstName\work directory.

Reviewing cluster log files
In case of problems while using the agent for SAP Web Application Server, you
can access the engine log file for more information about a particular resource. The
engine log file is located at drive:\Program Files\Veritas\Cluster
Server\log\engine_A.txt.

Additionally, you can also refer to the latest SAP Web Application Server agent log
files located at drive:\Program Files\Veritas\Cluster Server\log\SAPWebAS_A.txt.
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Note: Include both these log files while addressing the problem to Veritas support
team.

Using trace level logging
The ResLogLevel attribute controls the level of logging that is written in a cluster
log file for each SAP Web AS resource. You can set this attribute to TRACE, which
enables very detailed and verbose logging.

If you set ResLogLevel to TRACE, a very high volume of messages are produced.
Veritas recommends that you localize the ResLogLevel attribute for a particular
resource.

Warning: You may consider to temporarily increase the timeout values for
SAPWebAS for debugging purposes. After the debugging process is complete, you
can revert back to the original timeout values.

To localize ResLogLevel attribute for a resource

1 Identify the resource for which you want to enable detailed logging.

2 Localize the ResLogLevel attribute for the identified resource:

hares -local Resource_Name ResLogLevel

3 Set the ResLogLevel attribute to TRACE for the identified resource:

hares -modify Resource_Name ResLogLevel TRACE -sys SysA

4 Note the time before you begin to operate the identified resource.

5 Test the identified resource. The function reproduces the problem that you are
attempting to diagnose.

6 Note the time when the problem is reproduced.

7 Set the ResLogLevel attribute back to INFO for the identified resource:

hares -modify Resource_Name ResLogLevel INFO -sys SysA

8 Review the contents of the log file. Use the time noted in Step 4 and Step 6 to
diagnose the problem.

You can also contact Veritas support for more help.

Checks for an SAP Add-In Usage Types
For an SAP Add-In system, you must perform the following checks before further
investigations:
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■ The SAP resources running the ABAP and Java Central Services instances are
in the same Service Group.

■ The SAP resources running the ABAP and Java Enqueue Replication server
instances, are in the same Service Group.

Note: Veritas recommends to configure the Central Services and Enqueue
Replication server instances for an Add-In usage type in different service groups
to minimize the SPOFs in a service group.

■ Ensure the following:

■ The EnqSrvResName attribute of the Java Enqueue Replication server
instance is set to the VCS resource that is running the corresponding Java
Central Services instance (SCS).

■ The EnqSrvResName attribute of the ABAP Enqueue Replication server
instance is set to the VCS resource that is running the corresponding ABAP
Central Services instance (ASCS).
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Sample Configurations
This appendix includes the following topics:

■ About the sample configuration for the agent for SAP Web Application Server

■ Sample agent type definition for SAP WebAS

■ Sample SAP resource configuration in a physical environment

■ Sample service group configurations in a physical environment

■ Sample configuration in a virtual environment

About the sample configuration for the agent for
SAP Web Application Server

The sample configuration depicts the resource types, resources, and resource
dependencies within the service group. Review these dependencies carefully before
configuring the agent for SAP Web Application Server. For more information about
these resource types, refer to theCluster Server Bundled Agents Reference Guide.

Sample agent type definition for SAP WebAS
This section provides the sample agent type definition for SAP WebAS.

type SAPWebAS (

static i18nstr ArgList[] = { ResLogLevel, SAPAdmin,

SAPAdminDomain, SAPAdminPassword, SAPHome, SAPHost,

SAPMonHome, SAPServiceUser, SAPSID, InstName,

InstProfile, InstType, ProcMon, EnqSrvResName,

MonitorProgram, SecondLevelMonitor}

str ResLogLevel = INFO

AAppendix



str SAPAdmin

str SAPAdminDomain

str SAPAdminPassword

str SAPHome

str SAPHost

str SAPMonHome

str SAPServiceUser

str SAPSID

str InstName

str InstProfile

str InstType = APPSERV

str ProcMon[]

str EnqSrvResName

str MonitorProgram

int SecondLevelMonitor = 0

)

Sample SAP resource configuration in a physical
environment

Given the number of possible SAP resource configurations, this section provides
sample working examples that configure a specific SAP instance for Add-In
installations.

Sample SAP primary application server instance
An excerpt of the main.cf file for a SAP primary application server instance is as
follows.

SAPWebAS SAP710-PI1PAS_sap (

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\DVEBMGS22\\exe"

SAPHost = sappi1pas

SAPMonHome = "E:\\usr\\sap\\rfcsdk\\bin"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = DVEBMGS22

InstType = APPSERV

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\

PI1_DVEBMGS22_sappi1pas"
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ProcMon = { "disp+work.exe", "jstart.exe" }

)

Sample SAP additional application server instance
An excerpt of the main.cf file for a SAP additional application server instance is as
follows:

SAPWebAS SAP710-PI1PAS_sap (

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\D23\\exe"

SAPHost = sappi1aas

SAPMonHome = "E:\\usr\\sap\\rfcsdk\\bin"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = D23

InstType = APPSERV

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\

SYS\\profile\\PI1_D23_sappi1aas"

ProcMon = { "disp+work.exe", "jstart.exe" }

)

Sample SAP Central Services instance
An excerpt of the main.cf file for an SAP Central Services instance is as follows.

SAPWebAS SAP710-PI1SCS_scs (

Critical = 0

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\ASCS20\\exe"

SAPHost = sappi1scs

SAPMonHome = "E:\\usr\\sap\\PI1\\ASCS20\\exe"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = ASCS20

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\

PI1_ASCS20_sappi1scs"

InstType = ENQUEUE

ProcMon = { "msg_server.exe", "enserver.exe" }
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SecondLevelMonitor = 1

)

Sample SAP Enqueue Replication server instance
An excerpt of the main.cf file for a SAP Enqueue Replication server instance is as
follows.

SAPWebAS SAP710-PI1ERS_ers (

Critical = 0

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\ERS24\\exe"

SAPHost = sappi1ers

SAPMonHome = "E:\\usr\\sap\\PI1\\ERS24\\exe"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = ERS24

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\

PI1_ERS24_sappi1ers"

InstType = ENQREP

ProcMon = { "enrepserver.exe" }

EnqSrvResName = SAP710-PI1SCS_scs

SecondLevelMonitor = 1

)

Sample service group configurations in a physical
environment

This section provides sample service group configurations and dependencies in a
physical environment.

Sample service group configuration for ABAP and Java Usage types
The service group configuration in a cluster depends on some common
characteristics that must be part of the configuration design.

These characteristics include the following:

■ The SAP application server must be dependent on the database server
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■ Each SAP instance (Application Server, Enqueue, and Enqueue Replication)
should have a separate virtual IP address assigned to facilitate network
transparency.

■ Each SAP instance (Application Server, Enqueue and Enqueue Replication)
should be placed on shared disk to facilitate cluster node transparency.

■ Common file systems to include the profile, global and transaction file systems
should be managed from one or more shared disk objects. These systems must
be available to the SAP application via UNC path with SAPGLOBALHOST.

Figure A-1 shows the service group configuration for Application Server

Figure A-1 Service group configuration for Application Server
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Figure A-2 shows the service group configuration for SAP Central services instance
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Figure A-2 Service group configuration for SAP Central services instance
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Figure A-3 shows the service group configuration for Enqueue Replication Server
instance
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Figure A-3 Service group configuration for Enqueue Replication Server
instance
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Sample service group configurations for SAP systems on Windows
Server 2008/2012

This section provides the sample service group configurations and resource
dependency diagrams for SAP systems on Windows Server 2008/2012.

Sample configuration for SAP Central Services Instances
service group for Add-In installation Usage Type
This section provides the VCS main.cf for SAP Central Services Instances service
group for Add-In installation Usage Type.

group SAP-PI3SCS (

SystemList = { SysA = 0, SysB = 1 }

84Sample Configurations
Sample service group configurations in a physical environment



)

FileShare SAP-PI3SCS_sapmnt_FS (

PathName = "\\usr\\sap"

ShareName = sapmnt

LanmanResName = SAP-PI3SCS_Lanman

MountResName = SAP-PI3SCS_H_MountV

UserPermissions = { "'SAP_LocalAdmin'" = FULL_CONTROL,

"'Administrators'" = FULL_CONTROL,

"'SYMCORP\\SAP_PI3_GlobalAdmin'" = FULL_CONTROL,

"'SAP_PI3_LocalAdmin'" = FULL_CONTROL }

)

IP SAP-PI3SCS_IP (

Address = "10.xxx.xx.30"

SubNetMask = "255.255.252.0"

MACAddress = "00-15-17-63-45-92"

)

Lanman SAP-PI3SCS_Lanman (

VirtualName = sappi3scs

IPResName = SAP-PI3SCS_IP

)

MountV SAP-PI3ASCS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\ASCS29"

VolumeName = PI3ASCS_vol

VMDGResName = SAP-PI3ASCS_VMDg

)

MountV SAP-PI3SCS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\SCS30"

VolumeName = PI3SCS_vol

VMDGResName = SAP-PI3SCS_VMDg

)

MountV SAP-PI3SCS_I_MountV (

MountPath = "I:"

VolumeName = PI3SCS_I_vol

VMDGResName = SAP-PI3SCS_I_VMDg

)

MountV SAP-PI3SYS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\SYS"

VolumeName = PI3SYS_vol

VMDGResName = SAP-PI3SYS_VMDg

)

NIC SAP-PI3SCS_NIC (

MACAddress = "00-15-17-63-45-92"

)
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SAPWebAS SAP-PI3ASCS_SAPWebAS (

SAPSID = PI3

SAPHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"

SAPMonHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"

SAPHost = sappi3scs

ProcMon = { "msg_server.exe", "enserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQUEUE

InstName = ASCS29

InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_ASCS29_sappi3scs"

)

SAPWebAS SAP-PI3SCS_SAPWebAS (

SAPSID = PI3

SAPHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"

SAPMonHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"

SAPHost = sappi3scs

ProcMon = { "msg_server.exe", "enserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQUEUE

InstName = SCS30

InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_SCS30_sappi3scs"

)

VMDg SAP-PI3SCS_I_VMDg (

DiskGroupName = PI3SCS_I_dg

)

VMDg SAP-PI3ASCS_VMDg (

DiskGroupName = PI3ASCS_dg

)

VMDg SAP-PI3SCS_VMDg (

DiskGroupName = PI3SCS_dg

)

VMDg SAP-PI3SYS_VMDg (

DiskGroupName = PI3SYS_dg

)

SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_Lanman

SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_I_MountV

SAP-PI3SCS_IP requires SAP-PI3SCS_NIC
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SAP-PI3SCS_Lanman requires SAP-PI3SCS_IP

SAP-PI3ASCS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3ASCS_MountV requires SAP-PI3ASCS_VMDg

SAP-PI3SCS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3SCS_MountV requires SAP-PI3SCS_VMDg

SAP-PI3SCS_I_MountV requires SAP-PI3SCS_I_VMDg

SAP-PI3SYS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3SYS_MountV requires SAP-PI3SYS_VMDg

SAP-PI3ASCS_SAPWebAS requires SAP-PI3SCS_sapmnt_FS

SAP-PI3ASCS_SAPWebAS requires SAP-PI3ASCS_MountV

SAP-PI3ASCS_SAPWebAS requires SAP-PI3SYS_MountV

SAP-PI3SCS_SAPWebAS requires SAP-PI3SCS_sapmnt_FS

SAP-PI3SCS_SAPWebAS requires SAP-PI3SCS_MountV

SAP-PI3SCS_SAPWebAS requires SAP-PI3SYS_MountV

// resource dependency tree

//

// group SAP-PI3SCS

// {

// SAPWebAS SAP-PI3ASCS_SAPWebAS

// {

// FileShare SAP-PI3SCS_sapmnt_FS

// {

// Lanman SAP-PI3SCS_Lanman

// {

// IP SAP-PI3SCS_IP

// {

// NIC SAP-PI3SCS_NIC

// }

// }

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// }

// MountV SAP-PI3ASCS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3ASCS_VMDg

// }
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// MountV SAP-PI3SYS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3SYS_VMDg

// }

// }

// SAPWebAS SAP-PI3SCS_SAPWebAS

// {

// FileShare SAP-PI3SCS_sapmnt_FS

// {

// Lanman SAP-PI3SCS_Lanman

// {

// IP SAP-PI3SCS_IP

// {

// NIC SAP-PI3SCS_NIC

// }

// }

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// }

// MountV SAP-PI3SCS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3SCS_VMDg

// }

// MountV SAP-PI3SYS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3SYS_VMDg

// }

// }

// }
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Sample resource dependency for SAP Central Services
Instances service group for Add-In installation usage type
Figure A-4 shows the sample resource dependency diagram for SAP Central
Services Instances service group for Add-In installation Usage Type on a Windows
2008/2012 Server.

Figure A-4 Sample resource dependency diagram for SAPCentral Services
Instances service group for Add-In installation Usage Type on a
Windows 2008/2012 Server
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Sample configuration for SAP Enqueue Replication Server
Instances service group for Add-In installation Usage Type
group SAP-PI3ERS (

SystemList = { SysA = 0, SysB = 1 }

)

IP SAP-PI3ERS_IP (

Address = "10.xxx.xx.30"

SubNetMask = "255.255.252.0"

MACAddress = "00-15-17-63-45-92"

)

Lanman SAP-PI3ERS_Lanman (

VirtualName = sappi3ers

IPResName = SAP-PI3ERS_IP

)

MountV SAP-PI3AERS_MountV (

MountPath = "C:\\usr\\sap\\PI3\\ERS31"

VolumeName = PI3AERS_vol

VMDGResName = SAP-PI3AERS_VMDg

)

MountV SAP-PI3ERS_MountV (

MountPath = "C:\\usr\\sap\\PI3\\ERS32"

VolumeName = PI3ERS_vol

VMDGResName = SAP-PI3ERS_VMDg

)

NIC SAP-PI3ERS_NIC (

MACAddress = "00-15-17-63-45-92"

)

SAPWebAS SAP-PI3AERS_SAPWebAS (

SAPSID = PI3

SAPHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"

SAPMonHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"

SAPHost = sappi3ers

ProcMon = { "enrepserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQREP

InstName = ERS31

InstProfile = "\\\\sappi3scs\\sapmnt\\

PI3\\SYS\\profile\\PI3_ERS31_sappi3ers"

EnqSrvResName = SAP-PI3ASCS_SAPWebAS
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)

SAPWebAS SAP-PI3ERS_SAPWebAS (

SAPSID = PI3

SAPHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"

SAPMonHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"

SAPHost = sappi3ers

ProcMon = { "enrepserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQREP

InstName = ERS32

InstProfile = "\\\\sappi3scs\\sapmnt\\

PI3\\SYS\\profile\\PI3_ERS32_sappi3ers"

EnqSrvResName = SAP-PI3SCS_SAPWebAS

)

VMDg SAP-PI3AERS_VMDg (

DiskGroupName = PI3AERS_dg

)

VMDg SAP-PI3ERS_VMDg (

DiskGroupName = PI3ERS_dg

)

SAP-PI3ERS_IP requires SAP-PI3ERS_NIC

SAP-PI3ERS_Lanman requires SAP-PI3ERS_IP

SAP-PI3AERS_MountV requires SAP-PI3AERS_VMDg

SAP-PI3ERS_MountV requires SAP-PI3ERS_VMDg

SAP-PI3AERS_SAPWebAS requires SAP-PI3AERS_MountV

SAP-PI3AERS_SAPWebAS requires SAP-PI3ERS_Lanman

SAP-PI3ERS_SAPWebAS requires SAP-PI3ERS_MountV

SAP-PI3ERS_SAPWebAS requires SAP-PI3ERS_Lanman

// resource dependency tree

//

// group SAP-PI3ERS

// {

// SAPWebAS SAP-PI3AERS_SAPWebAS

// {

// MountV SAP-PI3AERS_MountV

// {

// VMDg SAP-PI3AERS_VMDg

// }

// Lanman SAP-PI3ERS_Lanman
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// {

// IP SAP-PI3ERS_IP

// {

// NIC SAP-PI3ERS_NIC

// }

// }

// }

// SAPWebAS SAP-PI3ERS_SAPWebAS

// {

// MountV SAP-PI3ERS_MountV

// {

// VMDg SAP-PI3ERS_VMDg

// }

// Lanman SAP-PI3ERS_Lanman

// {

// IP SAP-PI3ERS_IP

// {

// NIC SAP-PI3ERS_NIC

// }

// }

// }

// }

Sample resource dependency for SAPEnqueueReplication
Server Instances service group for Add-In installation
Usage Type
Figure A-5 shows the sample resource group dependency for SAP Enqueue
Replication Server Instances service group for Add-In installation Usage Type
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Figure A-5 Sample resource group dependency for SAPEnqueueReplication
Server Instances service group for Add-In installation Usage Type
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Sample service group dependency for SAP Web Application Server
This section includes service groups that show the group dependency for SAPWeb
Application Server.

Figure A-6 shows the sample service group dependency.
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Figure A-6 Sample service group dependency
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Sample configuration in a virtual environment
A sample main.cf configuration in a virtual environment that contains the Enqueue
instance, Enqueue Replication instance, Application Server instance, and SMDA
instance is as follows:

include "types.cf"
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cluster Cluster_59087 (

SecureClus = 1

)

system SAPVM21 (

)

system SAPVM22 (

)

group SAP_ASCS00 (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

UserAssoc = { Type = SAPWin, Name = SAP_ASCS00 }

)

IP SAP_ASCS00-IP (

Address = "10.xxx.xx.189"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

Lanman SAP_ASCS00-Lanman-sapenq (

VirtualName = sapenq

IPResName = SAP_ASCS00-IP

)

MountV SAP_ASCS00-Mount (

MountPath = "e:\\usr\\sap\\pi7\\ascs00"

VolumeName = SCSVOL

VMDGResName = SAP_ASCS00_SCSDG_VMNSDg

)

MountV SAP_ASCS00-Mount-1 (

MountPath = "e:\\usr\\sap\\pi7\\sys"

VolumeName = SYSVOL

VMDGResName = SAP_ASCS00_SCSDG_VMNSDg

)

NIC SAP_ASCS00-NIC (

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)
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SAPWebAS SAP_PI7_ASCS00_res (

Critical = 0

SAPAdmin = pi7adm

SAPAdminDomain = sap-domain

SAPAdminPassword = GUMsJUjOGmHMiMJmKMl

SAPHome = "E:\\usr\\sap\\PI7\\ASCS00\\exe"

SAPHost = sapenq

SAPServiceUser = SAPServicePI7

SAPSID = PI7

InstName = ASCS00

InstProfile = "\\\\sapenq\\sapmnt\\PI7\\SYS\\profile\\

PI7_ASCS00_sapenq"

InstType = ENQUEUE

ProcMon = { "enserver.exe" }

)

VMNSDg SAP_ASCS00_SCSDG_VMNSDg (

DiskGroupName = SCSDG

DGGuid = b26580c2-e773-4ca8-9e62-e03e235013c0

SkipStorageValidation = 1

)

VMwareDisks SAP_ASCS00-VMwareDisks (

ESXDetails = {

"vcslx658.vxindia.veritas.com" = "root=GUMsJUjOGmHMiMJ" }

DiskPaths = {

"6000C296-5313-69b0-63f9-f15efcf60d66:[NIMBSHARE] SAP_Win2k8_Vm1

/SAP_Win2k8_Vm1.vmdk" = "1:8" }

IsVMHAEnabled = 0

)

SAP_PI7_ASCS00_res requires SAP_ASCS00-Lanman-sapenq

SAP_PI7_ASCS00_res requires SAP_ASCS00-Mount

SAP_PI7_ASCS00_res requires SAP_ASCS00-Mount-1

SAP_ASCS00-IP requires SAP_ASCS00-NIC

SAP_ASCS00-Lanman-sapenq requires SAP_ASCS00-IP

SAP_ASCS00-Mount requires SAP_ASCS00_SCSDG_VMNSDg

SAP_ASCS00-Mount-1 requires SAP_ASCS00_SCSDG_VMNSDg

SAP_ASCS00_SCSDG_VMNSDg requires SAP_ASCS00-VMwareDisks

// resource dependency tree
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//

// group SAP_ASCS00

// {

// SAPWebAS SAP_PI7_ASCS00_res

// {

// Lanman SAP_ASCS00-Lanman-sapenq

// {

// IP SAP_ASCS00-IP

// {

// NIC SAP_ASCS00-NIC

// }

// }

// MountV SAP_ASCS00-Mount

// {

// VMNSDg SAP_ASCS00_SCSDG_VMNSDg

// {

// VMwareDisks SAP_ASCS00-VMwareDisks

// }

// }

// MountV SAP_ASCS00-Mount-1

// {

// VMNSDg SAP_ASCS00_SCSDG_VMNSDg

// {

// VMwareDisks SAP_ASCS00-VMwareDisks

// }

// }

// }

// }

group SAP_ERS10 (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

UserAssoc = { Type = SAPWin, Name = SAP_ERS10 }

PreOnline = 1

)

IP SAP_ERS10-IP (

Address = "10.209.69.193"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)
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Lanman SAP_ERS10-Lanman-sapers (

VirtualName = sapers

IPResName = SAP_ERS10-IP

)

NIC SAP_ERS10-NIC (

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

SAPWebAS SAP_PI7_ERS10_res (

SAPAdmin = pi7adm

SAPAdminDomain = sap-domain

SAPAdminPassword = GUMsJUjOGmHMiMJmKMl

SAPHome = "E:\\usr\\sap\\PI7\\ERS10\\exe"

SAPHost = sapers

SAPServiceUser = SAPServicePI7

SAPSID = PI7

InstName = ERS10

InstProfile = "E:\\usr\\sap\\PI7\\SYS\\profile\\PI7_ERS10_sapers"

InstType = ENQREP

ProcMon = { "enrepserver.exe" }

EnqSrvResName = SAP_PI7_ASCS00_res

)

SAP_PI7_ERS10_res requires SAP_ERS10-Lanman-sapers

SAP_ERS10-IP requires SAP_ERS10-NIC

SAP_ERS10-Lanman-sapers requires SAP_ERS10-IP

// resource dependency tree

//

// group SAP_ERS10

// {

// SAPWebAS SAP_PI7_ERS10_res

// {

// Lanman SAP_ERS10-Lanman-sapers

// {

// IP SAP_ERS10-IP

// {

// NIC SAP_ERS10-NIC

// }

// }
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// }

// }

group SAP_SMDA97 (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

UserAssoc = { Type = SAPWin, Name = SAP_SMDA97 }

)

IP SAP_SMDA97-IP (

Address = "10.209.69.192"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

Lanman SAP_SMDA97-Lanman-sapdi (

VirtualName = sapdi

IPResName = SAP_SMDA97-IP

)

NIC SAP_SMDA97-NIC (

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

SAPWebAS SAP_DAA_SMDA97_res (

SAPAdmin = daaadm

SAPAdminDomain = sapvm22

SAPAdminPassword = GUMsJUjOGmHMiMJmKMl

SAPHome = "E:\\usr\\sap\\DAA\\SMDA97\\exe"

SAPHost = sapdi

SAPServiceUser = SAPServiceDAA

SAPSID = DAA

InstName = SMDA97

InstProfile = "E:\\usr\\sap\\DAA\\SYS\\profile\\DAA_SMDA97_sapdi"

InstType = SMDA

ProcMon = { "jstart.exe" }

)

SAP_DAA_SMDA97_res requires SAP_SMDA97-Lanman-sapdi

SAP_SMDA97-IP requires SAP_SMDA97-NIC

SAP_SMDA97-Lanman-sapdi requires SAP_SMDA97-IP
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// resource dependency tree

//

// group SAP_SMDA97

// {

// SAPWebAS SAP_DAA_SMDA97_res

// {

// Lanman SAP_SMDA97-Lanman-sapdi

// {

// IP SAP_SMDA97-IP

// {

// NIC SAP_SMDA97-NIC

// }

// }

// }

// }

// }

group SAP_DVEBMGS01 (

SystemList = { SAPVM21 = 0 }

UserAssoc = { Type = SAPWin, Name = SAP_DVEBMGS01, UITimeout = 300 }

)

IP SAP_DVEBMGS01-IP (

Address = "10.209.69.191"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

)

Lanman SAP_DVEBMGS01-Lanman-sapapp (

VirtualName = sapapp

IPResName = SAP_DVEBMGS01-IP

)

NIC SAP_DVEBMGS01-NIC (

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

)

SAPWebAS SAP_PI7_DVEBMGS01_res (

SAPAdmin = pi7adm

SAPAdminDomain = sap-domain

SAPAdminPassword = gumSjuJogMhmImjMkmL

SAPHome = "E:\\usr\\sap\\PI7\\DVEBMGS01\\exe"
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SAPHost = sapapp

SAPServiceUser = SAPServicePI7

SAPSID = PI7

InstName = DVEBMGS01

InstProfile = "\\\\sapenq\\sapmnt\\PI7\\SYS\\profile\\

PI7_DVEBMGS01_sapapp"

ProcMon = { "disp+work.exe" }

)

requires group SAP_ASCS00 online global soft

SAP_PI7_DVEBMGS01_res requires SAP_DVEBMGS01-Lanman-sapapp

SAP_DVEBMGS01-IP requires SAP_DVEBMGS01-NIC

SAP_DVEBMGS01-Lanman-sapapp requires SAP_DVEBMGS01-IP

// resource dependency tree

//

// group SAP_DVEBMGS01

// {

// SAPWebAS SAP_PI7_DVEBMGS01_res

// {

// Lanman SAP_DVEBMGS01-Lanman-sapapp

// {

// IP SAP_DVEBMGS01-IP

// {

// NIC SAP_DVEBMGS01-NIC

// }

// }

// }

// }

group VCSInfraSG (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

UserAssoc = { Type = "vcs internal",

Name = "VCS Infrastructure service group" }

Parallel = 1

AutoStartList = { SAPVM21, SAPVM22 }

OnlineRetryLimit = 5

)

Process VCSNotifySinkRes (

StartProgram = "C:\\Program Files\\Veritas\\Cluster Server\\bin
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\\notify_sink.exe"

StartupDirectory = "C:\\Program Files\\Veritas\\Cluster Server\\bin"

)

// resource dependency tree

//

// group VCSInfraSG

// {

// Process VCSNotifySinkRes

// }
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